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EEDDIITTOORRIIAALL

Welcome to another issue of Full Circle!

This month's FCM brings you more of the usual goodness. Python (three years old
this month) and LibreOffice continue, and are joined by an article on setting up
DavMail for use with Microsoft Exchange. Tweet Screen fans can rest easy with the
thrilling conclusion to Charles' current Linux Labs experiment. In the land of

graphics, Mark's Inkscape series continues, and I've started a video editing series using
Kdenlive. And, by the end of this month's WebDev article, you'll have installed LAMP.

Next month, I'm hoping to have a review of the new book Ubuntu Made Easy from No
Starch Press (many thanks to them for the review copy), and a review of my new Google
Nexus 7 tablet. I've put up posts on our Google+ and Facebook pages encouraging people
to post Nexus 7 questions they'd like answered in the review.

Les and Co. have returned to the helm and released Full Circle Podcast #30, which you
should download. Running at almost two hours, it has a whole host of interviews, Raspberry
Pi info, and much much more.

Meanwhile, the eagle eyed proofreaders who fix all our mistakes (yours and mine) have
been working on the Official Full Circle Style Guide for all you writer types. We'll be
keeping this up to date and linking to it from future issues. This will be the reference guide
when writing an article. Many people are making simple mistakes (GB, not Gb or gb – yes,
there is a difference) which really should be corrected before submitting. The less we need
to change the better.

All the best, and keep in touch!
Ronnie

ronnie@fullcirclemagazine.org

This magazine was created using :

Full Circle Podcast
Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.

Hosts:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark

http://fullcirclemagazine.org

mailto:ronnie@fullcirclemagazine.org
http://goo.gl/FRTMl
http://facebook.com/fullcirclemagazine
http://fullcirclemagazine.org/2012/08/17/fullcircle-podcast-episode-30-better-late-than-never
http://fullcirclemagazine.org/2012/08/17/fullcircle-podcast-episode-30-better-late-than-never
http://url.fullcirclemagazine.org/75d471
http://www.scribus.net
http://www.gimp.org
http://www.libreoffice.org
http://creativecommons.org/
http://fullcirclemagazine.org
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LLIINNUUXX NNEEWWSS -- SSEECCUURRIITTYY AALLEERRTT

EPUB FORMAT

Finally, we have mobile editions
of Full Circle on the downloads
page. We're hoping to have
back issues online shortly. If
you've any problems with the
epub file/formatting, you can
drop an email to Jens at:
mobile@fullcirclemagazine.org

Google Currents

Install Google Currents on your
Android/Apple devices, search
for 'full circle' (in the app) and
add issues 55+ to your app. Or,
you can click the links on the
FCM download pages.

Software Centre

You can also get FCM via the
Ubuntu Software Centre:
https://apps.ubuntu.com/cat/,
Search for 'full circle', choose
an issue, and click the
download button.

Linux & OS X-only
Trojan Spotted

Security researchers have
discovered a potential dangerous
Linux and Mac OS X cross-
platform trojan.

Once installed on a
compromised machine, Wirenet-1
opens a backdoor to a remote
command server, and logs key
presses to capture passwords and
sensitive information typed by
victims. The program also grabs
passwords submitted to Opera,
Firefox, Chrome and Chromium
web browsers, and credentials
stored by applications including
email client Thunderbird, web
suite SeaMonkey, and chat app
Pidgin. The malware then
attempts to upload the gathered
data to a server hosted in the
Netherlands.

The software nastie was
intercepted by Russian antivirus
firm Dr Web [which] describes
Wirenet-1 as the first Linux/OSX

cross-platform password-stealing
trojan.

Multi-platform virus strains
that infect Windows, Mac OS X
and Linux machines are extremely
rare but not unprecedented. One
example include the recent Crisis
super-worm. Creating a strain of
malware that infects Mac OS X
and Linux machines but not
Windows boxes seems, frankly,
weird given the sizes of each
operating system's userbase -
unless the virus has been
designed for some kind of closely
targeted attack on an
organisation that uses a mix of
the two Unix flavours.

Analysis work on the Wirenet-1
is ongoing and for now it's
unclear how the trojan is
designed to spread. Once
executed, it copies itself to the
user's home directory, and uses
AES to encrypt its
communications with a server
over the internet.

Source: theregister.co.uk

Java Flaw Puts
Millions At Risk

Computer users - whether they
favour Windows, Mac or Linux
operating systems - are at risk
from a newly discovered Java
vulnerability for which there is
currently [as of 31st August
2012] no fix. It appears the flaw
allows the Blackhole exploit kit
to target the Java system using
a Pre.jar file that lets it install
malware, in this case a banking
Trojan, onto users machines,
through a variety of methods.

FireEye went on to criticise
Oracle - which owns Java - for its
lack of action regarding the
flaw. "It's very disappointing
that Oracle hasn't come forward
and announced a date for an
emergency update patch,"
wrote FireEye's Atif Mushtaq.

The flaw was uncovered
earlier in August.

Source: v3.co.uk

mailto:mobile@fullcirclemagazine.org
https://apps.ubuntu.com/cat/
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This month, I thought I
would move away from
the tutorials for once, and
instead introduce my

readers to the concept of an
Integrated Development
Environment (IDE), and explain a
few of the reasons why an
Integrated Development
Environment could be useful for
programmers. Following this, I will
name the IDEs I use, and also name
the languages for which I don't
feel I need an actual development
environment.

What is an IDE?

An IDE is basically an editor that
also contains a
compiler/interpreter and easy
access to documentation, and
usually offers plug-ins for

debugging and testing. Some of
the more advanced ones also offer
various forms of auto-completion.

Why use an IDE?
• Learn languages
• Makes managing larger projects
easier
• Easy access to
compiler/interpreter, debugger,
and testing environments

Using an IDE can make it much
easier to start using a language, as
it can offer corrections for typos
(or point out when you use
function calls from a different
language). If your IDE doesn't
highlight mistakes, it will at least
make it easy to quickly
compile/execute the code to check
for exceptions and run-time errors.

When you're working on larger
projects, it's usually helpful to use
an IDE that offers an integrated
file tree to keep track of what files
are where, and because they offer
tools to make debugging easier.
Once you have more than 100-200
lines of code, I would generally not
recommend trying to do your
debugging manually, and instead
use an actual testing and
debugging framework.

The sole exception to this, for
me, is Java. I always try to use
Eclipse with Java where possible,
simply because a number of
functions have long names, and
auto-completion can make life
easier. An alternative to this is
simply redefining functions into
shorter names, but that can get
extremely complicated. Since I'm

already in Eclipse when working
with Java, I tend to use the
integrated debugger regardless of
file size. Using something like jUnit
is overkill for most basic projects –
I use it only when I have multiple
files of a few hundred lines of code
– or if I'm required to do so for
class, or work.

What IDE should I use?

Ultimately, it comes down to
what you want to use. There are
some very advanced environments
like Eclipse (for Java or C++), which
will take up more space than a
basic IDE. The current version of
Eclipse requires just over 200MB of
space in Linux. Keep in mind that
the more features you have
running at a time, the more RAM is
used. Due to this, I find Eclipse too

CCOOMMMMAANNDD && CCOONNQQUUEERR
Written by Lucas Westermann

IIDDEEss
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Lucas has learned all he knows from
repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.

unwieldy. I use it with Java, and
Java alone, simply because that's
what my university required, and
as such it's what I'm used to.
Netbeans is another option for
Java/C/C++/PHP development.
However, I tend to not write many
large programs, and I find a text
editor and a terminal to be
sufficient for C, C++, and PHP.
Similarly with Python, although I
tend to use the interactive
interpreter for testing ideas
before I start coding.

The bottom line is simple. Think
about what you want to have easy
access to, how large your programs
usually are, and weigh the
pros/cons of learning a new
interface. Also, if you have time-

constraints, you may want to use
an IDE, as they can cut down
development and testing time (so
long as you are comfortable with
the interface). Once you've picked
out your reasons, find a few IDEs
that fulfil them, and try them out.
Repeat this until you find one
you're comfortable with (or that
meets your needs perfectly).

Light Table: A new IDE
concept

I recently saw a post by Chris
Granger on his take on an IDE
called Light Table. For a link, see
the Further Reading section below.
Since that post, he has successfully
funded the project on Kickstarter,

promised Python support after
Clojure, and released a prototype
(the “Light Table Playground”). I'm
extremely interested in the final
product. He's introduced some
new ideas (such as his “light”
workspace), and offered extremely
appealing implementations for all
other ideas. I've been using the
Light Table playground since it
came out, and I find the interface
to be cleaner than any other
interface I've ever seen. At the
moment, most of the functionality
in the concept video is unavailable,
offering mainly Instant Feedback
at this time. However, for anyone
who's fond of Clojure, or just wants
to take a look at something new, I
would recommend having a look.

I hope some of you have found
this article interesting, and that I
have answered at least a few of
your questions concerning IDEs. If
you have any more questions,
comments, or requests, you can
email me at lswest34@gmail.com.
If you decide to email me, please
include “FCM” or “C&C” in the
subject line, so that it doesn't get
lost in my inbox.

Further Reading:

http://www.chris-
granger.com/2012/04/12/light-
table---a-new-ide-concept/

http://app.kodowa.com/playgroun
d – Light Table playground

http://www.eclipse.org/downloads

http://netbeans.org/

COMMAND & CONQUER

mailto:lswest34@gmail.com
mailto:lswest34@gmail.com
http://www.chris-granger.com/2012/04/12/light-table---a-new-ide-concept/
http://app.kodowa.com/playground ? Light Table playground
http://www.eclipse.org/downloads
http://netbeans.org/
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HHOOWW--TTOO
Written by Greg D. Walters BBeeggiinnnniinngg PPyytthhoonn -- PPaarrtt 3366

Before I begin, I want to
note that this article
marks three years of the
Beginning Programming

using Python series. I want to
thank Ronnie and the entire staff
of Full Circle Magazine for all their
support and especially, you, the
readers. I NEVER thought that this
would continue this long.

I also want to take a second to
note that there has been some
comments floating around the
ether that, after three years, the
word “Beginning” might be
misplaced in the title of this series.
After all, after three years, would
you still be a beginner? Well, on
some levels, I agree. However, I
still get comments from readers
saying that they just found the
series and Full Circle Magazine,
and that they are now running
back to the beginning of the series.
So, those people ARE beginners.
So, as of part 37, we’ll drop
“Beginning” from the series title.

Now to the actual meat of this
article... more on Kivy.

Imagine you play guitar. Not air
guitar, but an actual guitar.
However, you aren’t the best guitar
player, and some chords are
problematical for you. For
example, you know the standard C,
E, G, F type chords, but some
chords – like F# minor or C# minor
– while doable, are hard to get your
fingers set in a fast song. What do
you do, especially if the gig is only
a couple of weeks away and you
HAVE to be up to speed TODAY?
The workaround for this is to use
the Capo (that funny clippy thing
that you see sometimes on the
neck of the guitar). This raises the
key of the guitar and you use
different chords to match the rest
of the band. This is called
transposing. Sometimes, you can
transpose on the fly in your head.
Sometimes, it’s easier to sit down
on paper and work out that if, for

example, the chord is F# minor and
you put the capo on fret 2, you can
simply play an E minor. But that
takes time. Let’s make an app that
allows you to simply scroll through
the fret positions to find the
easiest chords to play.

Our app will be fairly simple. A
title label, a button with our basic
scale as the text, a scrollview (a
wonderful parent widget that
holds other controls and allows
you to “fling” the inside of the
control to scroll) holding a number
of buttons that have repositioned
scales as the text, and an exit
button. It will look SOMETHING
like the text below.

Start with a new python file
named main.py. This will be
important if/when you decide to
create an Android app from Kivy.

Now we’ll add
our import
statements
which are shown
on the next page, top right.

Notice the second line,
“kivy.require(‘1.0.8’)”. This allows
you to make sure that you can use
the latest and greatest goodies
that Kivy provides. Also notice that
we are including a system exit (line
3). We’ll eventually include an exit
button.

Here is the beginning of our
class called “Transpose”.

class Transpose(App):

def exit(instance):

sys.exit()

Now we work on our build

­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­

Transposer Ver 0.1

C C#/Db D D#/Eb E F F#/Gb G G#/Ab A A#/Bb B C

____________________________________________________________________

1| C#/Db D D#/Eb E F F#/Gb G G#/Ab A A#/Bb B C C#/Db

2| D D#/Eb E F F#/Gb G G#/Ab A A#/Bb B C C#/Db D

­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­



full circle magazine #64 8 contents ^

HOWTO - BEGINNING PYTHON 36
routine (middle right). This is
needed for every Kivy app.

This looks rather confusing.
Unfortunately, the editor doesn’t
always keep spaces correct even in
a mono-spaced font. The idea is
that the text1 string is a simple
scale starting with the note “C”.
Each should be centered within 5
spaces. Like the text shown
bottom right.

The text2 string should be the
same thing but repeated. We will
use an offset into the text2 string
to fill in the button text within the
scrollview widget.

Now we create the root object
(which is our main window)
containing a GridLayout widget. If
you remember WAY back when we
were doing other GUI
development for Glade, there was
a grid view widget. Well, the
GridLayout here is pretty much the
same. In this case, we have a grid
that has one column and three
rows. In each of the cells created in
the grid, we can put other widgets.
Remember, we can’t define which
widget goes where other than in
the order in which we place the
widgets.

root =

GridLayout(orientation='verti

cal', spacing=10,

cols=1,rows=3)

In this case, the representation
is as follows....

­­­­­­­­­­­­­­­­­­­­­­­­­­­­­

(0) title label

­­­­­­­­­­­­­­­­­­­­­­­­­­­­­

(1) main button

­­­­­­­­­­­­­­­­­­­­­­­­­­­­­

(2) scrollview

­­­­­­­­­­­­­­­­­­­­­­­­­­­­­

The scrollview contains multiple
items – in our case buttons. Next,
we create the label which will be at
the top of our application.

lbl = Label(text='Transposer

Ver 0.1',

font_size=20,

size_hint=(None,None),

size=(480,20),

padding=(10,10))

The properties that are set
should be fairly self-explanatory.
The only ones that might give you
some trouble would be the

padding and size_hint properties.
The padding is the number of
pixels around the item in an x,y
reference. Taken directly from the
Kivy documentation size_hint (for
X which is same as Y) is defined as:

Xsize hint. Represents howmuch

space thewidget shoulduse in the

direction ofthe Xaxis, relative to its

parent’swidth. OnlyLayoutand

Windowmake use ofthe hint. The

value is in percentas a floatfrom 0.

to 1., where 1. means the full size of

his parent. 0.5 represents50%.

In this case, size_hint is set to
none, which defaults to 100% or 1.
This will be more important (and
convoluted) later on.

Now we define our “main”
button (next page, top right). This
is a static reference for the scale.

Again, most of this should be

import kivy

kivy.require('1.0.8')

from sys import exit

from kivy.app import App

from kivy.core.window import Window

from kivy.uix.button import Button

from kivy.uix.label import Label

from kivy.uix.anchorlayout import AnchorLayout

from kivy.uix.scrollview import ScrollView

from kivy.uix.gridlayout import GridLayout

def build(self):

#­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­

text1 = " C C#/Db D D#/Eb E F F#/Gb G G#/Ab A A#/Bb B C"

text2 = " C C#/Db D D#/Eb E F F#/Gb G G#/Ab A A#/Bb B C C#/Db D

D#/Eb E F F#/Gb G G#/Ab A A#/Bb B C C#/Db"

#­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­

| | | | | | | | | | | |

12345678901234567890123456789012345678901234567890123456

C C#/Db E F F#/Gb G G#/Ab A A#/Bb B C



full circle magazine #64 9 contents ^

Greg is the owner of RainyDay
Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1972. He enjoys
cooking, hiking, music, and spending
time with his family. His website is
www.thedesignatedgeek.net.

HOWTO - BEGINNING PYTHON 36
fairly clear.

Now we add the widgets to the
root object, which is the
GridLayout widget. The label (lbl)
goes in the first cell, the button
(btn1) goes in the second.

#­­­­­­­­­­­­­­­­­­­­­­­­­­­­

root.add_widget(lbl)

root.add_widget(btn1)

#­­­­­­­­­­­­­­­­­­­­­­­­­­­­

Now comes some harder-to-
understand code. We create
another GridLayout object and call
it “s”. We then bind it to the height
of the next widget which, in this
case, will be the ScrollView, NOT
the buttons.

s = GridLayout(cols=1,

spacing = 10, size_hint_y =

None)

s.bind(minimum_height=s.sette

r('height'))

Now (middle right) we create
20 buttons, fill in the text
property, and then add it to the
GridLayout.

Now we create the ScrollView,
set its size, and add it to the root
GridLayout.

sv =

ScrollView(size_hint=(None,

None), size=(600,400))

sv.center = Window.center

root.add_widget(sv)

Lastly, we add the GridLayout
that holds all our buttons
into the ScrollView, and
return the root object to
the application.

sv.add_widget(s)

return root

Finally, we have our “if
__name__” routine. Notice
that we are setting
ourselves up for the
possibility of using the
application as an android
app.

if __name__ in

('__main__','__android__'):

Transpose().run()

Now you might wonder why I
used buttons instead of labels for
all our textual objects. That’s
because labels in Kivy don’t have
any kind of visible border by
default. We will play with this in
the next installment. We will also
add an exit button and a little bit
more.

The source code can be found
on PasteBin at
http://pastebin.com/hsicnyt1

Until next time, enjoy and thank
you for putting up with me for
three years!

btn1 = Button(text = " " + text1,size=(680,40),

size_hint=(None, None),

halign='left',

font_name='data/fonts/DroidSansMono.ttf',

padding=(20,20))

for i in range(0,19):

if i <= 12:

if i < 10:

t1 = " " + str(i) + "| "

else:

t1 = str(i) + "| "

else:

t1 = ''

text2 = ''

btn = Button(text = t1 + text2[(i*5):(i*5)+65],

size=(680, 40),

size_hint=(None,None),

halign='left',

font_name='data/fonts/DroidSansMono.ttf')

s.add_widget(btn)

#­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­

http://www.thedesignatedgeek.net
http://pastebin.com/hsicnyt1
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HHOOWW--TTOO
Written by Elmer Perry LLiibbrreeOOffffiiccee PPtt1177:: MMaaccrrooss

I recently got a request for a
tutorial on LibreOffice
macros, so we will take a short
break from our work in

Impress to briefly cover macros.
Macros allow you to automate
repetitious actions like typing a
letterhead. This frees you from
having to type or do the same task
over and over again. In this how-to,
we will cover how to record macros
and use them. LibreOffice has a
Basic scripting language which is
beyond the scope of this particular
how-to. Perhaps we will revisit
macros at a later time to discuss
the Basic scripting language.

NOTE: You can find information on
LibreOffice Basic in the help, or
download the documentation at
http://wiki.documentfoundation.or
g/images/d/dd/BasicGuide_OOo3.
2.0.odt.

Enabling Macro
Recording

By default, macro recording is
disabled. Apparently, macros are
considered an “experimental

(unstable) feature”. To enable
macro recording, Tools > Options.
Select the General options under
LibreOffice, and check “Enable
experimental (unstable) features”.
This enables the “Record Macro”
option under Tools > Macros.

Recording a Macro

When in macro record mode,
the macro recorder tracks every
action you make and all the text
you type, and records it in the
macro. Remember how we had to
enable experimental features to
get the Record Macro option? Well,
that's because sometimes the
macro recorder does fail. I haven't

experienced this myself, but I
thought I should point that out.

As a demonstration of
recording a macro, we will create a
macro called Closing. Every time
you write a letter, you have to end
with a closing, so why not make it
into a macro.

Start with a new text document.
Tools > Macros > Record Macro to
start the macro recorder. The
macro recorder toolbar will show.
There is only one choice on this
toolbar, Stop Recording. Press the
Tab key on your keyboard three or
four times (this should place the
cursor close to the center of the

page). Type Best wishes, love, or
your favorite closing. Press Enter
twice to leave room for a
signature. Press Tab the same
number of times you did before.
Change the text to bold by clicking
the Bold button on the formatting
toolbar, and type in your name.
Lastly, let's add a title under the
name. Press Enter, Tab the same
number of times as before, click
the Bold button to turn off bold,
and click the Italic button to
change to italics. Type in your title.
Press Enter. Click on Stop
Recording.

The Basic Macros dialog box will
show. Select the library where you
want to save your macro, usually
My Macros. Enter a name in the
Macro name textbox, and click the
Save button.

Testing Your Macro

You will want to test your
macro to insure everything
recorded correctly, Tools > Macros
> Run Macro. The macro dialog box
will show. Select the library where
you saved your macro, select your

http://wiki.documentfoundation.org/images/d/dd/BasicGuide_OOo3.2.0.odt
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HOWTO - LIBREOFFICE Pt17
macro, and click on the Run
button. The macro will run,
repeating all the text you typed
and the formatting you did.

If something didn't turn out just
right, you can delete the macro
and create a new one. To delete a
macro, Tool > Macros > Organize
Macros > LibreOffice Basic. Find
your macro in the library, select it,
and click the Delete button.

Create a Shortcut to
your Macro

If you use a macro a lot, you
don't want to go to Tools > Macros

> Run Macro every time you need
to use the macro. LibreOffice
allows you to add your macros to
menus, toolbars, keyboard
shortcuts, and application events.
You can add your macros through
Tools > Customize.

As an example, let's add a menu
named Macros in Writer and add
our Closing macro to it. Tools >
Customize. Select the Menus tab.
Click the New button. Name the
new menu Macros. Use the arrow
buttons to move it from the
bottom to the position before
Help. Click OK. Your new menu is

empty right now. Click on the Add
button. Under category, find
LibreOffice Macros and navigate
through the tree to find your
macro. Select the Closing macro
and click the add button. The
macro is added to the menu. Click
on the Close button. Click OK on
the Customize dialog box. You will
now have a menu item named
Macros, and, under it, the Closing
macro. Now, you can select it from
the menu when you need it, which
is faster than having to navigate to
Run Macro.

This has been a very short
introduction to macros. Before
deciding to use a macro, make sure
there isn't a better way to
accomplish what you are trying to
do, but for often repeated action,

macros might just be the solution
you are looking for. There is a
LibreOffice Basic scripting
language, and perhaps we will
cover it in the future. You can also
download macros from the web
that you can import and use in
LibreOffice.

Next time, we are back to
Impress and working with slides.

Elmer Perry's history of working,
and programming, computers
involves an Apple IIE, adding some
Amiga, a generous helping of DOS
and Windows, a dash of Unix, and
blend well with Linux and Ubuntu.
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Written by Jan Mussche DDaavvMMaaiill

There are different ways to
open and read your mail.
You can use web-mail,
where you read your mail

on a web page belonging to the
website of your provider or of a
third party, you can use an e-mail
program such as Thunderbird,
Evolution or one of many others.
With an e-mail program you can
sometimes choose between POP
and IMAP.

Sometimes, however, using one
of these possibilities is not
enough. There are other ways –
like, for example, the Microsoft
(who else?) Exchange server using
OWA (Outlook Web Access). This is
used just by Microsoft because

well, let's be gentle, they want to
be different.

For those who use Evolution as
an E-mail program, there is good
news. Evolution has the Evolution
Exchange Connector, which can be
installed from the standard
repositories. For Thunderbird, and
many other programs, there is not
such an easy way to connect to an
Exchange server.

Happily there is DavMail. The
latest version (since 2012-07-10) is
3.9.9. For Debian/Ubuntu/Mint
they have a deb-file present on
http://davmail.sourceforge.net/
where you can get more info about
the program, and where you can

download it.

After installation, you start the
program and you are greeted by
settings windows (below). In here,
there are just a few things which
you need to set up.

In the Main Tab, the only item is
the OWA URL. I have my address
hidden to prevent troubles. What
you can still see is the extension
/exchange/

For the server I use, this is

mandatory; no idea if this applies
with other Exchange servers,
probably the same.

On the last tab, called
Advanced, there is also just one
setting which is important (below)
it's the one next to the mouse
pointer in the screenshot. Untick
this box otherwise you will end up
with double mail messages in your
sent items folder.

I did not change any other
setting and it works great.

http://davmail.sourceforge.net/
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In your mail program (and I use
Thunderbird, but I guess settings
like these are very common), I had
to set up the connection like this:

When setting up the account,
you start by choosing an IMAP Mail
server. The name is called
localhost. Here, you do not enter
the real name of the mail server.

This is done in DavMail.

The two are connected through
port 1143. When you look at the
1st DavMail screenshot, you also
see port 1143 used for IMAP mail.
The numbers used here are 1000
larger than the real numbers( 1143
-143, 1025 – 25, 1110 – 110).

As User Name, I had to use
domain\username but this is
something your local IT guy can tell
you. For the company I work for I
have to do it like this.

Setup a new SMTP server with
the settings shown below.

Also here you see the changed
port number (1025) and also here I

had to use the format
domain\username in the User
Name field.

That's it. When you have set up
DavMail this way (and added an
account in, for example,
Thunderbird – like I explained), you
should be seeing your company's
mail in a few seconds.

Question remains: do you want
to see these mail messages at
home? That's something you have
to answer for yourself.

To make sure DavMail is always
running when you need it, add it to
the list of programs which start
when the system boots.
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Written by Ronnie Tucker VViiddeeoo EEddiittiinngg WWiitthh KKddeennlliivvee -- PPaarrtt 11

In this series of tutorials, I’d
like to show you the basics of
video editing using the KDE
application Kdenlive. Many

people seem to think there are no
good video editing apps on Linux,
Kdenlive (I think) proves them
wrong.

There is a Kdenlive in the
official repositories, but it is now
old and I’d recommend that you
install the latest version (0.9 as I
write this) by loading up your
software center/package manager
and adding the PPA to your
software sources:

ppa:sunab/kdenlive­release

Reload your list of packages,
and then install the kdenlive
package.

If you prefer the terminal, use:

sudo add­apt­repository

ppa:sunab/kdenlive­release &&

sudo apt­get update && sudo

apt­get install kdenlive

Here’s Kdenlive when you first
load it up:

Top left of the window is the
area where all your clips will be
stored; every clip that you will
possibly use in the current project
will be loaded into here. In the
middle is your stack of effects and
their properties. Top right is the
monitor area. It’s here that you
view clips or preview your project.
The bottom half of the window has
three video tracks (horizontal

rows) and two audio tracks. At the
very bottom right of the window
are some controls, but the one
you’ll use here is the slider to zoom
in/out of your previews.

Essentially, you drag your clips
from the top left to one of the
audio/video tracks and arrange
them in their preferred playing
order. There’s more to it than that,

but we’ll come to that in later parts
of the tutorial. Let’s do a quick
import and arrangement to get
you used to Kdenlive.

First thing you want to do is
make sure that your new project
(which is currently open) is set to
the right video size, and so on. So,
in the Kdenlive menu, click Project
> Project Settings.

Kdenlive comes with ‘Profiles’
which you can see in the drop
down menu below ‘Video Profile’.
These profiles are a group of
settings which you can use if
you’re making a DVD, (S)VCD, HD
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and so on. I’m just tinkering here,
so I’m going to choose DV/DVD
PAL (PAL since I’m in the UK). You
choose what works best for you or
your clips. When you choose a
profile, you’ll see the information
below the drop-down change to
show what your project will be in
size, frame rate, and so on. Click
OK to return to the main screen.

Now, go to the menu and click
Project > Add Clip, and select
however many audio/video clips
that you’d like to use in your
project.

You may see a window
appearing to tell you that some
clips are not the correct size for
your project. If your clips are too
small they’ll be enlarged and frame
rates adjusted. This could cause
problems later, but for now I’m
clicking OK to continue.

Now is a good time to go to the
menu and click File > Save, and give
your project a name.

Here I have two clips, both with
sound. What I’ll do is drag the first
clip down to the ‘Video 1’ track,
and then drag the second clip
down to the ‘Video 2’ track – but
place it at the end of the first clip
(shown below right)

If you click in the timeline (just
above the ‘Video 1’ track), you’ll be
able to jump/scroll through the
video. Or, if you like, you can watch
by clicking the play button below
the monitor (top right). The
squiggly line below the video
preview in each video track is a
graph showing the sound volume
of each clip.

Having one video finish and

abruptly start the next isn’t always
pleasant, so before we wrap up
this part, let’s add a quick fade
effect where we’ll fade from the
Video 1 track to the Video 2 track.

OK, zoom in to your previews
which are showing on the video
tracks. Either use the slider at the
bottom right of the window, or the
+ and - buttons at either side of the
slider (next page, top right).

What we need to do here is
overlap the two tracks. The

amount of overlap is how long the
fade will take (next page, middle
right).

This fade should take about two
seconds.

Right click on the Video 1 clip
and choose Add Transition >
Dissolve. You’ll see a box
overlaying both tracks (next page,
bottom right). Click it and you’ll
see some properties showing up
beside your list of clips.
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Ronnie is the founder, and editor, of
Full Circle, an official Ubuntu
member, and part-time artist whose
work can be seen at:
http://ronnietucker.co.uk

HOWTO - KDENLIVE Pt 1
In the properties, tick the

‘Reverse’ box.

Scrub through the video (click,
hold, and drag through the
timeline), or play the video, and
you’ll see the fade from Video 1 to
Video 2.

To create a final video – with
your clips joined and the fade
effect – go to Project > Render.

In the left panel you choose
which type of video you’d like to
export as, and, on the right, the
size and so on. Above that you give
the file a name; the other stuff
we’ll leave as is. Click ‘Render to

File’ (at the bottom left of the
window) and off it’ll go.

If there’s anything you’d like to
see covered in this series, please
drop me an email at:
ronnie@fullcirclemagazine.org.

Next month we’ll talk about
effects, and more on adding clips.

http://ronnietucker.co.uk
mailto:ronnie@fullcirclemagazine.org


full circle magazine #64 17 contents ^

HHOOWW--TTOO
Written by Mark Crutch IInnkkssccaappee -- PPtt44

This month, we're going to
look at setting colors for
our objects. So far we've
applied colors to the fill

and stroke of our objects by
clicking and SHIFT-clicking on the
palette at the bottom of the
screen. You can also set either to
transparent by using the leftmost
palette entry – the one with a
cross through it. You've probably
already discovered the scroll bar
that usually lives between the
palette and the status bar, and
which lets you scroll through the
full collection of colors in the
palette, but have you noticed the
tiny little button to the right of the
palette area – the one that looks
like a small “<” character? Clicking
on that presents you with a pop-up
menu of palette options (far right).

Most of this menu is taken up
by a list of palettes you can use.
Try switching between a few of
them to see how they look. Then
play with the Size and Width sub-
menus to find a swatch size that
you're comfortable with. Finally,
try the Wrap checkbox to see
whether you prefer to see all of

your palette at once (even if it
takes up more vertical space), or
are happy to use the scrollbar
when you need to access the more
distant colors.

If you want to use your own
palette – perhaps to fit in with a
corporate color scheme or to
integrate with other icons in an
application – you can drop a GIMP
palette file (.gpl) into your
.inkscape/palettes directory, or
into /usr/share/inkscape/palettes
if you want it to be available to all
users on your computer.

The palette is great
for quickly selecting a
color for your fill or

stroke, but what if you want a
color that's not present in the
palette? That's where the Fill &
Stroke dialog comes in. There are
various ways to open the dialog,
including the button on the
Commands toolbar, selecting an
object then picking 'Fill and Stroke'
from the right-click context menu,
pressing CTRL-SHIFT-F, or simply
clicking on the current fill and
stroke swatches at the bottom-left

of the window. You may dock the
dialog to the right-hand side of the
Inkscape window, or move it into a
window of its own, by dragging it
using the grey title bar at the top.

At the top of the dialog are
three tabs for setting the Fill, the
Stroke Paint, and the Stroke Style.
The first two offer almost identical
options, so we'll just discuss the
Fill tab and you can extrapolate
from there.
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Immediately below the tab is a

row of buttons which are used to
determine what type of paint is
used for the fill or stroke. At the
left is a button for 'No Paint' which
looks like a cross and has the same
effect as using the crossed swatch
at the left of the palette in the
main drawing window. If both the
fill and stroke are set to No Paint,
then your object will be completely
invisible.

The second button lets you
choose a single color for your fill or
stroke. In that respect, it's the
same as selecting from the palette,
except that you have much finer
control over the color. Choosing
this button presents you with yet
more tabs offering a few different
methods for picking your color.
Don't be fooled though: Inkscape
uses RGB (Red, Green, Blue) values
in its files even if you select a color
via the HSL or CMYK tabs. This is
one example of Inkscape being
restricted by the capabilities of the
SVG format. The CMS tab is only of
use if you set up a color
management system on your
computer, and is outside the scope
of this series.

Whichever color picker you
choose, you'll find a slider at the

bottom labelled with an 'A'. This is
the 'alpha channel', which is just
another term for opacity. If this
slider is moved to the far left, then
your fill or stroke will be
completely transparent. To the far
right, it's completely opaque.
Anywhere in between will make it
partially transparent. This image
demonstrates the same two
objects with the stroke fully
opaque, but the top object's fill
alpha being set at the 0, 128 and
255 levels (above).

As with the No Paint option,
setting the alpha channel for both
the fill and stroke to zero will
render your object completely
invisible. If the fill or stroke is
partially transparent, the color
swatches in the bottom-left corner
of the status bar in the main
window will show a two-part
arrangement: the left half shows
the color with the alpha applied
over a checkerboard effect, while
the right half shows an opaque
version of the same color. You can

easily make a translucent fill or
stroke completely opaque via the
context menu on the swatch.

The third and fourth buttons let
you use a gradient for your fill or
stroke. Gradients will be the
subject of next month's article, so
remember that these buttons
exist, but we'll skip over them for
now.

The next button lets you paint
your fill or stroke using a pattern.
Inkscape ships with a variety of
stripes and polka dots which are
available via a pop-up menu when
you select this option. Most
patterns are black or white, with
just one color pattern
(Camouflage) and three grayscale
bitmap images that can be used as
patterns, right at the bottom of
the list. It is possible to create your
own patterns and to adjust the size
and scale of the built-in patterns,
but those are subjects for another
day.

Also being put off for later
articles are the Unset Paint button
that looks like a question mark and
the two splodges on the right of
the Fill tab.

The third main tab on the Fill
and Stroke dialog is labelled as
Stroke Style. While the Stroke
Paint tab is used to set the color,
gradient or pattern that is used for
the stroke, this tab lets you
manage all the other parameters.
Most of these settings can be
adjusted only by using this dialog,
so it's worth becoming familiar
with it.
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At the top is a spin-box for
setting the width of the stroke,
and an associated pop-up menu for
picking the units that the width is
measured in. These duplicate the
functionality available from the
right-click menu on the status bar,
but offer a greater choice of units
and finer control over the width.
SVG currently allows the stroke to
only straddle the outline of the
object, half inside and half outside
it. You can see this clearly by
reducing the alpha channel on a
thick stroke – notice that the fill
shows through the inner half of
the stroke. It's worth
remembering, as Inkscape novices
often wonder why increasing the
stroke also reduces the area inside
their shapes.

Next are three radio buttons
labelled as Join. These determine
how the corners of your objects
are drawn – either as sharp
(mitred), rounded or bevelled

corners. The difference between
them can easily be seen by drawing
a star (above left).

When a mitred corner is
particularly sharp, the point of the
join may extend quite some way. In
this case Inkscape will switch to
drawing a bevelled corner instead.
The length that the point is
allowed to grow to, before this
switch occurs, is set by the Mitre
Limit spin-box.

The Cap buttons affect the ends
of your lines. Most of the objects
we've drawn so far are continuous
loops, so the ends aren't really
clear, but if you use the circle
handles to turn an ellipse into an
arc then you'll have an object with
obvious ends. The middle option,

Round Cap, finishes your lines with
a semicircular smooth extension to
the end. The other two options,
Butt Cap and Square Cap, both give
a squared-off end to your line, and
differ only in whether the square
extends beyond the nominal end
of the line (Square Cap), or stops
precisely at that point (Butt Cap).

The stroke doesn't have to be a
single continuous line, it can
consist of a repeating pattern of
dashes. Anyone who has spent
time with technical drawings will
be familiar with the dash-dot-dash
of a center line, and a series of
dashes can be used to give a
stitched effect for artistic
purposes. The Dashes pop-up lets
you choose from a variety of dash
patterns built into Inkscape, with

the adjacent spinbox letting you
adjust the relative start position of
your pattern. The Cap buttons also
play a big part when it comes to
dash patterns – this image shows
our star with a thick dashed stroke
using each of the three cap
settings (above right).

The three pop-up menus for
Start, Mid and End Markers allow
you to select arrowheads, circles,
squares and other shapes which
will be positioned on your stroke.
Once again, the Start and End
options make most sense on an
unclosed line, such as an arc. On a
closed line, you'll probably want to
use only one or the other. The Mid
Markers appear wherever there is a
corner or a transition to a different
line segment – which includes the
transition from straight to curved
segments on a rounded rectangle.
This image shows just three
examples of markers and dash
patterns in use (bottom).
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One big caveat with markers is

that they will appear in black,
regardless of the color of your
stroke. Fortunately Inkscape does
ship with an extension that tweaks
the necessary SVG internals for
you, so making the colors match is
as simple as selecting your marker-
laden object, and then heading up
to the menu bar to choose
Extensions > Modify Path > Color
Markers to Match Stroke. Even
using this extension, however,
markers are always opaque,
regardless of the alpha setting of
your stroke.

The last part of the Fill and
Stroke dialog to explain is the pair
of sliders at the bottom – to adjust
the Blur and Opacity. The former is
a convenient shortcut for adding
the Gaussian Blur filter to an
object. SVG filters are a major topic
of their own that we'll look at in a
later article, but, for now, it's
enough to know that increasing
this slider will cause your object to
become blurred. The more you
increase it, the more blurred your
object will be. Don't go too
overboard: usually a small value
will give you a good effect, whilst
larger values just dissipate your
object into mist. Be aware that
using filters will slow the speed at

which Inkscape redraws the screen,
especially if you're zoomed in
closely.

The opacity slider has the same
effect as the 'O' spin-box and
context menu on the status bar,
but with more fine-grained control.
Changing this value affects the
opacity of the entire object – both
the fill and the stroke. Effectively,
the object is drawn in memory
using the fill and stroke alpha
values, then that whole image is
drawn to the screen using the
object opacity. This cumulative
effect makes it possible to

combine transparency values in
complex ways that wouldn't be
possible with just alpha or just
opacity. In this rather garish
example the squares have 100%
opacity and alpha throughout, but
the circles have the fill, stroke and
opacity values indicated:

The opacity slider is one way to
make some use out of those
colorless fill patterns. By
duplicating an object (Edit >
Duplicate), and then filling the
copy with a pattern and reducing
its opacity, you can let the original
object's color show through.

Why not use that trick on your
snowman image to give a little
graininess to the covering of snow
on the ground with the addition of
the Sand texture at a low opacity.
Add in some color tweaks, a bit of
blurring, and some translucency on
the shadows, and you should find
that, with your new found mastery
of the Fill and Stroke dialog, your
image is starting to look a little
less flat.

http://www.peppertop.com/
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Written by Michael R. Youngblood WWeebb DDeevv -- PPtt22

Last month, we installed
Apache2 and did a little bit
of configuration. This
month we will be installing

and configuring MySQL, PHP, and
CouchDB. MySQL is a relational
database, and CouchDB is a non-
relational database. We will get
familiar with both types of
databases over the life of this
article. PHP is a server-side
language that allows us to do all
sorts of amazing things.

CouchDB is the starting point of
this article. Even though it is not
traditionally part of the LAMP
stack, installing it now and learning
it will be beneficial to your skills as
a web developer. We are not going
to go over any configurations for
this until it is time to start using it.
This way, you will know which
settings you want to change, and
what you want to change the
values to. Start by updating and
upgrading your software and then
apt-get couchdb:

sudo apt­get update

sudo apt­get upgrade

sudo apt­get install couchdb

Yes, it really is that simple to
install a lot of things. The next
installation is just as easy, and it
prompts you only to set a “root”
password. Please note, that just
because it says root password, this
is not referring to the server’s root
password. Make a note of this
password, as this will identify the
user with the ultimate power in the
databases. Ok, let’s get to the
installing:

sudo apt­get install mysql­

server

The next part asks you a few
questions regarding the security of
your database. I suggest answering
with “Y” to all of them. The
question specifically asks about
remote access with the root user.
This disallows any access to MySQL
unless you are on the same server
(SSH to the server, and then
logging in is still allowed in this
scenario).

mysql_secure_installation

Now that you are all done with
the installation and basic
configuration of MySQL, you need
to test it to make sure everything
is working fine. To login, simply
type in “mysql -u root -p” into the
terminal. It will prompt you for the
password you just set, and, upon
successful entry, you will be
greeted with the mysql prompt
that usually looks like this:
“mysql>”.

aliendev@server:~$ mysql ­u

root ­p

Enter password:

Welcome to the MySQL monitor.

Commands end with ; or \g.

Your MySQL connection id is

310

Server version: 5.1.61­

0ubuntu0.10.10.1 (Ubuntu)

Copyright (c) 2000, 2011,

Oracle and/or its affiliates.

All rights reserved.

Oracle is a registered

trademark of Oracle

Corporation and/or its

affiliates. Other names may

be trademarks of their

respective

owners.

Type 'help;' or '\h' for

help. Type '\c' to clear the

current input statement.

mysql>

We are almost done, with just
one last thing to get set-up. PHP5
is a widely used server-side
language that will help you in the
long run (even if you don’t use it).
To install it is very simple:

sudo apt­get install php5

php­pear

Going forward, you will want to
make sure the following values are
set in the php.ini (PHP’s
configuration file), and relevant
lines are uncommented (the
commented lines start with a
semicolon, uncommenting them is
as easy as removing the
semicolon). So, open up the php.ini
file with vi (“sudo vi
/etc/php5/apache2/php.ini”), and
look for these lines – hint: you can
type “/” (forward slash) and a term
and press enter to search in vi):

max_execution_time = 30

memory_limit = 64M
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error_reporting =

E_COMPILE_ERROR|E_RECOVERABLE

_ERROR|E_ERROR|E_CORE_ERROR

display_errors = Off

log_errors = On

error_log = /var/log/php.log

register_globals = Off

Any time you make changes to
the php.ini file, you will need to
restart Apache. You can do this
simply by using one of the
following commands:

sudo /etc/init.d/apache2

restart

sudo service apache2 restart

The very last thing we are going
to do is add MySQL support for
PHP, and install a PHP package
that will add some additional
security. Also note, because we are
changing something that Apache
will need to know, we need to

restart it again. We could have
waited, but I wanted to point out
that there are a few ways to do this
and that it needs to become a
habit when making changes to
Apache.

sudo apt­get install php5­

mysql php5­suhosin

sudo service apache2 restart

Congratulations, you officially
have a LAMP stack, and we can
start developing next month.
Cheers!

Michael Youngblood has been in the
industry of web design and
development for 13 years. He has
been working for a world wide
wireless tech corp for six years and is
working on his bachelor’s of science
in mobile development.

BBRRIIDDGGEESS

Solutions are on the second last page.

An island is shown by a circle with a number in it. Draw
bridges between islands so that each island has the
number of bridges indicated. There can be no more than
two bridges between the same two islands. Bridges can
only be drawn horizontally or vertically.

puzzles are copyright, and kindly provided by,
The Puzzle Club - www.thepuzzleclub.com

http://www.thepuzzleclub.com
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Guidelines

The single rule for an
article is that it must
somehow be linked to
Ubuntu or one of the

many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc).

Write your article in whichever
software you choose. I would
recommend LibreOffice, but
PLEASE SPELL AND GRAMMAR
CHECK IT!

Writing

There is no word limit for
articles, but be advised that long
articles may be split across several
issues. In your article, please place
where you would like a particular
image to be. Please do not use any
formatting in your document.

Images

Images should be no wider than
800 pixels, in JPG format, and use
low compression.

If you are writing a review,
please follow these guidelines :

For a more detailed list of the
style rules and common pitfalls
please refer to:
https://wiki.ubuntu.com/UbuntuM
agazine/Style - in short: US
spelling, no l33t speak and no
smilies.

When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

If you can't write articles, but
hang out in Ubuntu Forums, send
us interesting forum threads that
we could print.

Non-English Writers

If your native language isn't
English, don't worry. Write your
article, and the proof-readers will
read it for you and correct any
grammatical or spelling errors. Not
only are you helping the magazine
and the community, but we'll help
you with your English!

REVIEWS

Games/Applications
When reviewing games/applications please state clearly:

• title of the game
• who makes the game
• is it free, or a paid download?
• where to get it from (give download/homepage URL)
• is it Linux native, or did you use Wine?
• your marks out of five
• a summary with positive and negative points

Hardware
When reviewing hardware please state clearly:

• make and model of the hardware
• what category would you put this hardware into?
• any glitches that you may have had while using the hardware?
• easy to get the hardware working in Linux?
• did you have to use Windows drivers?
• marks out of five
• a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.

https://wiki.ubuntu.com/UbuntuMagazine/Style
articles@fullcirclemagazine.org
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https://spideroak.com

Get 25% off any SpiderOak package
with the code: FullcirclemagFans

https://spideroak.com
https://spideroak.com
https://spideroak.com/mobile
https://spideroak.com
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AASSKK TTHHEE NNEEWW GGUUYY
Written by Copil Yáňez

Hi, everyone! Welcome
back to Ask the New
Guy! If you’re new to
Ubuntu, thinking about

switching to Linux, or need
something explained to you like
you’re five, look no further. I am
here to answer your very basic
questions from the perspective of
someone who knows he should
care about the epic battle between
vi and Emacs, but has a soufflé in
the oven, so, yeah, no.

This month, I heard from a
brave gentleman named John
Hughes. Presumably not the iconic
director of The Breakfast Club
because not only is Director John
Hughes dead, I have it on good
authority he was a BSD freak all
the way.

Ubuntu John asks:

I'm a 71 yearoldwannabe

geek, with a question. I'm

runningUbuntu 12.04, and

have downloadedandinstalled

Rainlender2 calendar. Program is

great. Does justwhat Iwant.

HoweverIdon'tknowhowtomake

itautostartat login andshowup on

mydesktop. Can you help?

In a word, John, no. But
ignorance has never kept me from
flailing about like I lit myself on fire
– so here goes.

First of all, John was kind
enough to include the version of
Ubuntu he’s working with. This is
very helpful to savvy Linux users.
But since I’m not one of those, that
information is completely wasted
on me. He might as well have asked
his question and then told me he
slurps canned sardines from the

tin. The information would be just
as useful as knowing his operating
system, but would have the added
advantage of letting me know
what kind of person asks for
computing advice from a complete
moron like me. Seriously, John, it’s
like getting arrested for B.A.S.E.
jumping, and then asking the guy
who did your caricature portrait at
the county fair to represent you in
court.

You see, John, I’m running
Lubuntu – which is based on
Ubuntu but runs a bit better on an
old IBM Thinkpad I inherited from

my wife. And by “inherited” I mean
“wiped the hard drive and installed
a new operating system while she
slept.” You would think that if I
figured out your problem in
Lubuntu, you could simply apply
the solution to Ubuntu and be on
your merry way, checking your
calendar with reckless abandon.

But I cannot count the number
of times I’ve found a solution on a
forum and then copy/pasted
strings of unintelligible characters
into a terminal (because no one
who knows the answer to your
question has ever heard of a
mouse, much less graphical menus)
– only to find they were meant for
a different Linux flavor than mine
resulting in unintended computing
behaviors. Like whenever I go to
shutdown my machine now, I
automatically post a webcam
picture of myself to Facebook.

The best I can do is explain how
I got Rainlendar to autoload on
Lubuntu. Maybe the process on
your machine will be similar. But
then again, maybe it’ll be like
eating a porcupine. Dunno. Think

“
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of my guidance as a mere outline
of what your eventual solution will
be, a ghost image of the correct
solution, which I killed with a
candlestick in the conservatory.

Right. So the first thing I did
was type the following into
Google:

Lubuntu autostart program

Here’s the top result:
http://askubuntu.com/questions/8
1383/how-can-i-add-new-
autostart-programs-in-lubuntu

Now, I know this magazine’s
readers are going to give a
collective gasp, but I use menus
quite a bit. The cool thing (cool as
in “neato!” – not cool as in, you
know, actually cool) about Linux is
that you can do most things by
clicking on menus or by typing
stuff into a terminal (which just
sounds so final and scary, like a
serial killer with a grudge). I have
no doubt my solution can be
converted to a string of characters
that would make this whole thing a
simple cut-and-paste job. And
someday, I hope to be more
proficient and knowledgeable at
the command line because when
you understand the command line,

you understand Linux. But I don’t
understand either just yet.
Seriously, I barely understand
toothpaste. So we’re learning
together here, John. Do what
works for you, I’m just telling you
what worked for me. And, since
this is Ask the New Guy and not
Ask a Smart Guy or even Ask a
Marginally Literate Guy, I’m gonna
use the mouse.

So the first thing I do is click on
the File Manager and type
/usr/share/applications.

I find exactly what I was told I
would, a folder with icons for all
the programs installed on my
system. Maybe it’s more accurate
to say I’ve found a bunch of
shortcuts to the programs on my
system. Dunno, I’m New Guy,
remember? Anyway, the point is, I

have a place where I can find all
the programs on my system in a
way that’s easy to copy from. Also,
I haven’t borked my system so I’m
putting this one in the win column.

Next, I scroll through the icons
and find Rainlendar2, right click on
it and select Copy. I’ve got a copy
of the program (or a copy of a link
to a program or a symbolic
representation of a file or
whatever--look I have what I need,
let’s break out the glow sticks and
keep this rave going!). Now I need
a place to put it.

So I type ~/.config/autostart

Wait a sec. I typed
~/.config/autostart but it takes me
to /home/copil/.config/autostart?
WTH?! I want my money back!

I suspect it has something to do
with that pesky tilde (~) symbol.
I’ve only understood it in the
context of my own name (where,
Lord knows, it’s given me enough
grief). I have no clue what it’s
doing here. Well, turns out the
tilde is the Linux word for
/home/username (where
“username” is whatever you call
your home folder). So, when I type
~/.config/autostart, it takes me to
/home/copil/.config/autostart.
Huh, neat trick, Linux. You can stay.
. . FOR NOW. . .

As promised, the autostart
folder is where I find. . . wait for it. .
. A LIST OF ALL THE PROGRAMS
THAT ARE SUPPOSED TO
AUTOSTART!

John, I am so excited at this
point, I shave my legs! Hey, we all
deal with success in different ways.
Don’t judge me, John.

Now that I’m in the autostart
folder, I simply right-click and
select Paste. I’m done! Time to

ASK THE NEW GUY

http://askubuntu.com/questions/81383/how-can-i-add-new-autostart-programs-in-lubuntu
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crack open a freshie and celebrate
another milestone! Then, after a
two-day celebratory bender, I
double-check that the solution
works. I restart my Lubuntu laptop
and, sure enough, Rainlendar2
starts up without my having to find
it in a menu, run it from the
command line, or ask Swithins, my
butler, to do it. Swithins has other
things to do with his valuable time,
like heat up a tubful of Evian for
my daily bath.

John, I know what you’re
thinking. You’re thinking, “Where
do I find a decent Linux butler?”
Well, I found Swithins on Craigslist
in the M4P (Male for Penguin) sub-
category. But you’re probably also
wondering how this can help YOU
since you’re not running Lubuntu.
Well, you’ve been such a good
sport until now, I’m going to see
what I can do for you under
Ubuntu 12.04.

I visit Google.com and type:

Ubuntu autostart programs

Here’s the first search result:
http://www.liberiangeek.net/2012
/05/windows-7-vs-ubuntu-12-04-
how-to-automatically-start-
programs/

Holy baloney, John! It’s even
easier in Ubuntu! I could have
saved myself 1,500 words (and
you’d have five minutes of your life
back).

Fasten your jockstrap, John,
here we go!

1. Click on the gear icon in the
upper right corner of your desktop
2. Select startup applications
3. In the new window, click Add
4. In the new window, click Browse
5. In the new window, click File
System along the left and then
double-click the usr folder
6. Now double-click the bin folder
7. Scroll down until you find
Rainlendar2 (or just start typing it
and it will find YOU)
8. Click Open at the bottom right
of the window
9. In the new window, click Add
10. Now click “I just made Ubuntu
my bey-otch” because you’re
DONE!

Yes, I know I buried the lead. I
could have just started with the
Ubuntu solution. But we’ve both
learned a little something about
tildes, filepaths and autostart
folders. Sometimes the search is
more revealing than the solution

(got that from a fortune cookie).
The biggest benefit, of course, is
that you and I got to spend quality
time together, John.

Pardon? Oh, you don’t agree.
Well then, I’ll just be on my way.

On other pages in this
magazine, you’ll find command line
solutions to your problems. But
the command line is the deep end
of the pool. I’m here to hand out
floaties and water wings until
we’re all ready to use the diving
board. If you can use Ubuntu, then
you’ll continue to use Ubuntu (also
got that in a fortune cookie - the
cook was a sys admin).

Hopefully I’ve shown you that
stuff like this is totally doable. If I
can do it then a bag of hammers
can do it. Not that I’m calling you a
bag of hammers, John. My answers
here are designed to instill trust
and confidence in users like you
and me who may not think we’re
capable of doing this stuff, but,
turns out, we totally are!

In all seriousness, John, we
appreciate your question and
hopefully you’ve been able to play
along at home and get your
Rainlendar calendar to autostart. If

not, let me know (I’ll have Swithins
give you a call).

Best of luck, John!

Am I alone? Anyone else out
there know how to summon the
command line but fear its voodoo?
Or maybe you get tired of
answering the same questions over
and over for new users. If so,
contact me at
copil.yanez@gmail.com. I’ll try to
answer simple questions, or point
out helpful beginner advice from
the perspective of someone who
loves Linux and Ubuntu but doesn’t
speak source code.

ASK THE NEW GUY

Copil is an Aztec name that roughly
translates to “you need my heart for
what again?” His love of women’s
shoes is chronicled at
yaconfidential.blogspot.com. You
can also watch him embarrass
himself on Twitter (@copil).

http://yaconfidential.blogspot.com
mailto:copil.yanez@gmail.com
http://www.liberiangeek.net/2012/05/windows-7-vs-ubuntu-12-04-how-to-automatically-start-programs/
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LLIINNUUXX LLAABB
Written by Charles McColm

TTwweeeett SSccrreeeenn -- PPaarrtt 22

In issue #62, we looked at the
software side of creating the
Tweet Screen, this month we
look at the hardware side.

WARNING - this will definitely void
your notebook’s warranty! Before
starting, a few words on some of
the objectives:
• keep the cost down
• use only available tools and
materials if possible
• it has to be stable and sturdy

Materials:
IBM Thinkpad R31 (when I wrote
this I saw a R31 for £40 on
ebay.co.uk)
• Lenovo 3000 C100 notebook
(approximately £38 - see below)
• Black 11” x 14” frame
(approximately £9.51 from an art
store) with 1 inch depth
• Electrical tape

Tools:
• small technician's screwdriver set
• junior hacksaw
• dremel
• round and square files
• grounding strap
• safety glasses

Just after issue #62, I ran into
video issues with the Thinkpad
R31. Since I’d already pre-tested
Tweet Screen on my own aging
notebook, a Lenovo 3000 C100,
and I found it several times on
ebay with better specifications for
less money than the Thinkpad R31.
I used the 3000 as the basis for
part 2 of our Tweet Screen article.

The Lenovo 3000 C100 comes in
2 models, one with a Celeron
1.5GHz CPU and Broadcom
wireless chipset, and one with a
Pentium 4 1.7GHz CPU and Intel
wireless chipset. The model used
in this article is the Celeron-based
model. Both models have identical
15” LCD screens.

In part one of this article, we
covered the software side of
setting up the Tweet Screen. In
part two, we’ll cover disassembling
and installation of the notebook in
an 11” x 14” picture frame. I found
the picture frame after visiting a
couple of art stores. Having
created a notebook picture frame
several years ago, I knew it was
important to have as much depth

as possible to hold the notebook.
Most art stores had frames with
more than 1 inch depth, but the
glass was often set almost at the
back of the frame, rendering it
useless. The frame I chose was 1
inch thick with the glass a few
millimeters from the front.

A number of years ago when I
built the notebook picture frame, I
made a couple of related mistakes:
1) I didn’t buy/build a frame big
enough to hold the components of
the notebook. 2) In further
attempting to reduce the amount
of parts in the notebook, I did not

test the notebook enough during
the second disassembly process.

This time, before disassembly,
the notebook stuck out about ¼”
inch. This time I tested often and
decided not to attempt to remove
everything from the notebook,
keeping the disassembly as simple
as possible. Additionally, I installed
SSH, set up the notebook’s
wireless, and gave the notebook’s
wireless a DHCP reservation on our
router in case I needed to remotely
shut down the machine (which
turned out to be a great step).
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Ideally, disassembly should be

done on an anti-static mat. I didn’t
have one handy so I used an anti-
static strap connected to a metal
ground. I had a large motherboard
anti-static bag handy, but since I
only ever exposed the screen and
the front bezel above the
notebook keyboard, it really wasn’t
necessary.

Disassembly started with taking
out the battery and DVD-RW, then
testing to make sure the notebook
powered on. The Lenovo 3000
C100 has a slide switch that
conveniently pops out the battery.
Removing the battery eliminates
heat and lessens the weight of the
entire unit. The DVD-RW is held in
by a small, F3, single screw.

Most of the screws on the
bottom of the unit are either of

the F3 (short type used to secure
the memory lid, hard drive, screen,
and DVD-RW). or F6 (longer type
used to keep the case together).
Only two other longer screws
securing the screen base to the
notebook were removed at a later
stage. I kept the screws organized
on a couple of long stickers
marked F6 and F3, and later
deposited these in an inexpensive
plastic sorting box I bought at a
dollar store.

Next, I bent the screen
backwards so it was almost level
with the notebook. The plastic
bezel on the front of the notebook
(where the buttons and LEDs are)
is a long strip of plastic, about an
inch thick, and can be removed by
prying up the left side and gently
pulling up the rest of the strip. I
used the small slot head of the

notebook screwdriver to do this.
With the bezel off, I marked
around the power switch using a
felt marker.

At this point I tested the
notebook using the plastic end of
the screwdriver to power on the
unit. Because the unit boots right
to the Visible Tweets screen, each
time I shut down I needed to hit
the F11 key to show the Chromium
browser minimize/maximize/close
buttons (alternatively, I could have
probably just hit Ctrl+Alt+Del to
bring up the shutdown menu, but I
did things the hard way).

The next job was to remove the
casing from the screen. While this
is one of the thinnest parts of the
notebook, the latch at the top
which secures the screen to the

notebook when closed would
make it impossible to lie the screen
flat on the glass. Most laptops
have stiff round plastic covering a
number of screws. In the case of
the 3000 C100, there were 6 small
F3 screws hiding behind the plastic
cylinders. I used the smallest slot
head to pry up the plastic cylinders
then used a small Phillips
screwdriver to remove the screws.

After removing the front panel
plastic from the screen, I noticed a
couple more screws securing the
wireless antennas to the top of the
screen. At the bottom of the
screen lay the screen inverter. I
carefully removed the tape
securing the inverter to the back of
the case, then unscrewed the
antennas and removed the plastic
LCD backing.
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Removing the backing reveals
that the LCD is secured to the
notebook by a couple of thin metal
rods with several small screws on
each side. These rods are secured
to the base of the notebook by a
couple of long screws. Initially I
removed these screws, but found
working with the screen
unmanageable, so I secured them
back in until I removed the screws
securing the LCD to the rods.

Just after removing the back
plastic portion of the LCD case,

look at the back of the LCD. On the
back of the Lenovo 3000 C100
screen is tape cautioning not to
touch the backlight portion near
the top of the LCD. Of course I had
already touched it without
realizing, so at this point I powered
on the notebook and tested again -
thankfully it booted. Note that the
backlight electronics were covered
by a thin film of plastic, but they
might not be on all notebooks.

With the screen detached from
the metal rods, the next job was to
secure it on the back/bottom of

the notebook. But before
attaching the screen, I peeled a
thin film of tinfoil-like metal off
the back plastic LCD panel. This
metal film acts as an anti-static
shield. I carefully removed the
metal foil and attached it to the
bottom of the notebook, taking
care to cut out a small square to
vent the memory area. Much of the
stickiness of the foil had stuck to
the back plastic panel no longer in
use, so I used electrical tape to
secure the foil to the bottom. I also
used electrical tape to secure the
screen to the plastic base of the
notebook, taking care not to cover
too much of the screen or leave
metal exposed.

With the screen on the opposite
side of the keyboard I now tested
the unit once again. This time
shutting the unit down via
keyboard and trackpad proved
quite difficult, even with a mirror.
Happily I had already set up a static
DHCP reservation for the machine,
and installed SSH so I remotely
shut it down over SSH.

sudo /sbin/shutdown ­h now

At this point, I had a bit of the
inverter wire inconveniently placed
at the top. Normally this wire is
channeled into the LCD screen, but
it proved to be quite helpful in the
end adding a few extra millimeters
so that the top and bottom fit
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snugly inside the picture frame.
This left a gap just shy of 1
centimeter on each side of the
frame.

With the notebook in the frame
I marked off an area of ventilation
at the bottom and the area the
power core was to plug into the
system. With this done I removed
the notebook and cut out the
marked off areas. I’d love to claim
that I did this expertly, but the
truth is I used what I had at my
disposal, a junior hacksaw and a
dremel.

To smooth out the roughness
left by my cutting I used a couple
of files to file down the cut out

areas so they were nice and
smooth. Surprisingly, it turned out
well enough that I was able to
reuse the wood block from the
ventilation cut out. This block I cut
in half and filed down. I put one of
each block in the 1 centimeter gap
between the notebook and frame.
These small blocks kept the
notebook from moving within the
frame.

At this point the Tweetscreen
was finished, it could stand on its
own without falling out the back. It
was time to fire it up again for one
last shot.

With a bit more time I would
have filled in the sides and used a

wooden bracket to secure the
system further. I also would have
rigged up a button on the side so I
wouldn’t have to power the system
on from the back. As the Tweet
screen sits now it works well, and
could be hung except for the
power button detail. Set on a desk
it looks great and feeds us all the
tweets about refurbishing,

Kwartzlab, and different Ubuntu
topics.

Next month, a look at our local
Hacker Space Kwartzlab. Kwartzlab
is the host of a number of
interesting projects from the
original Twitter screen I mentioned
in Issue 62 to hosting Ubuntu code
and bug sprints.
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CCLLOOSSIINNGG WWIINNDDOOWWSS WWaallllppaappeerr && TThheemmeess

Written by:
Ronnie Tucker (KDE)
Jan Mussche (Gnome)
Elizabeth Krumbach (XFCE)
Mark Boyajian (LXDE)

Right clicking on your Windows
XP desktop and choosing
Properties will take you to the
Display Properties window, and
it’s from here you can change your
desktop theme and wallpaper.

Kubuntu

Kubuntu (and KDE in general)
works in a very similar way. Right
clicking on the desktop and
choosing Desktop Settings will give
you a window from which you can
either change your desktop to a
preinstalled image, or add a
desktop wallpaper using the
‘Open...’ button.

As well as getting the usual
options to scale/resize/crop your
wallpaper image, you can also
choose to either have your
wallpaper as an image, a slideshow
or a colour gradient.

As for a theme, this is where
KDE differs slightly. Open the
System Settings, then open the
Workspace Appearance. Here you’ll
see two main things: Window
Decorations and Desktop Theme.

Window Decorations is used to
change the appearance of your
windows, or window borders if you
like.

Desktop Theme is where you
change the look of everything else,
such as your taskbar, widgets, etc.
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Clicking the Details tab will let you
fine tune the desktop theme
should you want to mix and match.

Gnome-Shell

Changing wallpapers in Gnome
is very easy. Just right-click on an
empty part of the desktop and
choose the last entry in the drop-
down menu called Change Desktop
Background. Some standard
desktop pictures are supplied. If
the right one is not in the list you
can always choose to download
more from the net. To do that,
choose: Get more backgrounds
online.

Opening the window to change
the desktop background is also
possible by using the menu
structure: System > Preferences >
Appearance.

When you look at the top of the
window, you’ll notice the first tab
is called Theme. Here you can
change the complete theme – in
other words change the way your
desktop looks. Just as with the
background pictures, a number of
predefined themes have been
included in the installation. Also
here, when you have a different

taste, you can download more
themes online. Another possibility
is to select the theme that’s as
close as possible to your wishes,
and then adjust it so it will become
your theme.

Select a theme and click on the
button Customize. A window
appears in which you can do almost
everything to set the theme the
way you want it to be. Just
experiment with it. Even when you
don’t manage to get it exactly as
you want it, you might stumble on
another one which is even better.

It’s all very straightforward. The
nice thing is you can’t do anything
wrong, so just go ahead and try it.

Lubuntu

Unlike the other desktops
discussed here, Lubuntu goes to
great lengths to keep all aspects of
the desktop and management
thereof as lean as possible by
default. And “lean” is what
Lubuntu is all about, so we’ll limit
this discussion to the default
options since, as has been
mentioned in previous installments
of this series, you can access the
repositories and customize

Lubuntu to be as “heavy” as you
want.

To manage the most basic
desktop settings, right-click any
unoccupied area of the desktop
and select Desktop Preferences
from the pop-up menu to open the
window of the same name. By
default, the Appearance tab has

focus on which you can set
Background options for the
desktop as well as specify text
options for text that displays with
objects placed on the desktop (e.g.
icons).

The two options for
selecting/setting wallpaper don’t
get much simpler than this!

CLOSING WINDOWS
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Clicking the Wallpaper “field”
opens the file manager, and this
allows you navigate to the image
you want to use as your wallpaper.
The Wallpaper mode option opens
a pop-up menu that allows you to
specify how you want the image
displayed on the desktop (e.g.
stretched, centered, etc.). The Text
options determine how text
associated with desktop objects
(e.g. icons) is displayed.

To select Themes, control
window appearance and behavior,
and configure other desktop
options, open the Openbox
Configuration Manager (from the
main menu, select Preferences >
Openbox Configuration Manager).

By default, the Theme category
is selected. As you can see,
Lubuntu comes with several
Themes (12) by default, and you
can add new themes at any time.
To change a theme, simply click on
the theme example displayed; this
will immediately apply the theme
throughout the system, even to
windows that are already open.
Clicking on other categories
reveals their respective
configuration options. (Note: The
Mouse category actually
determines the behavior of
windows based on mouse
movement/actions.)

For even more control over the
display of your desktop, from the

main menu select Preferences >
Customize Look and Feel, which
opens the window of the same
name.

The options available in this
window allow for considerable
customization and “tweaking” of
many different parameters
including custom foreground and
background colors for windows,
tooltips, etc, changing icon
themes, mouse cursor themes
(Note: none are installed by
default), window borders, and
more. There is some overlap in
functions between this window
and the Openbox Configuration
Manager, but the information is
displayed [in their respective

windows] differently.

Lastly, you can also control the
appearance of the Panel on the
desktop. Right-click on any
unoccupied area of the Panel and,
from the pop-up menu, select
Panel Settings; this opens the
Panel Preferences window.

Click on the Appearance tab to
configure the look of the panel by
changing its background and font.
By default, “image” is selected as
the background for the panel. Click
on the “field” to the right of the
“image” radio button, and the file
browser will open to the panel
images directory where there are
many (>20) images from which to

CLOSING WINDOWS
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choose by default. Obviously, you
can add more if you want.

Xubuntu

In Xubuntu, like many other
desktops, launching the settings
dialog to change the background
can be done by right-clicking on
the desktop and selecting
“Desktop Settings...” from the
menu. The dialog will give you
several default options, as well as
the option to upload your own
desktop background and define
how you want it placed on your
screen (centered, tiled, stretched,
etc), and, if it doesn’t fill your
whole screen, what background
color to use and how that should
be styled (solid, horizontal or
vertical gradient).

You can also launch this menu
by clicking on the Mouse icon >
Settings > Settings Manager >
Desktop.

Like KDE, Xfce has the desktop
appearance split into two different
components, the GTK Theme
(called Appearance Style) and a
Window Manager Theme.

The Appearance Style dialog is

opened via Mouse icon > Settings >
Settings Manager > Appearance,
and here you select what style you
wish to use to determine desktop
color pallet, including contrast.
Several options come with
Xubuntu by default, and, by
selecting them, they will be
applied immediately – so you can
see what it looks like. The full
Appearance settings menu also
allows you to change what icons,
fonts and some other settings to
use.

The Window Manager Theme
dialog is opened via Mouse icon >
Settings > Settings Manager >
Window Manager, and this is used
to change the theme of the actual
window borders. Just like with the
Appearance Style dialog, selecting
on one of the many options that
comes with Xubuntu by default will
immediately apply that theme so
you can check it. In addition to
Style settings, the Window
Manager dialog has options to
change keyboard shortcuts,
window focus behavior, and more.

By default, Xubuntu uses the
Greybird style for both Appearance
and Window Manager themes.

CLOSING WINDOWS
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MMYY SSTTOORRYY
Written by Nathan Peek

There I am, keyboard on my
lap, feet propped up,
energy drink at the ready,
and a mass of Hot Pockets

in the freezer singing their alluring
siren song. I agree with the Hot
Pockets that yes, I will meander
over there and select one of you
for consumption as soon as I finish
one more paragraph; I’m writing a
research paper at the time. When,
suddenly, staring deeply into my
disposition is the lovely blue
screen of death. Yet again,
Windows had managed to
perfectly time a system crash when
I’m in the zone. My cat, Penelope,
jumps up onto the computer desk,
blinks softly, and meows as if to
say, “You know what to do.”

Now, I’m a systems engineer
who manages a few persistently
connected network segments of
which all servers run a flavor of
Linux. I’m a fanatic. I’ve often
wondered why is it that my own
house is run by Windows? It’s some
sort of paradox. I opine that it
must be because I share out
folders to stream to my Xbox. I
then decide folder streaming is a

weak excuse – I pet Penelope, sip
my energy drink, and get to work.

It goes like this: bounce PC,
backup files, select Hot Pocket, put
Hot Pocket into microwave,
download Ubuntu 12.04, burn to
disk, retrieve Hot Pocket, retrieve
extra Fire Sauce packets, bounce
PC, boot to CD, squirt sauce into
halved pocket, bite into still-too-
hot Hot Pocket and chew from one
side of my mouth to the other. I
get to the partition manager of the
Ubuntu installation and nefariously
say to the Windows partition,
“Goodbye Windows, I want to say it
was a good run, but no, you ruined
my life.” It is at that point I part
ways with Windows and gleefully
begin upon, as the American
Constitution iterates I’m allowed
to do, my pursuit of happiness.

What follows is: install
proprietary drivers, install Guake,
finish Hot Pocket, install Wine,
install Foxit Reader, install
VirtualBox, pet Penelope, install
Chrome, install Opera, configure
Ubuntu One, pull down Hotot ppa,
configure AskUbuntu lens, finish

energy drink, synchronize
browsers, marvel at my shiny new
installation while quoting Dr.
Frankenstein, “It’s alive! Alive!”

To solve the issue of Xbox
streaming, I snatch my XP Pro disk
and say to it, “We meet again”. I
reluctantly install a Windows
virtual machine. The idea here is
that, when I need it, I’ll detach my
external drive from Ubuntu and
attach it to the virtual Windows
machine. Streaming conundrum
solved. However, there was one
issue I did not previously consider;
my wife.

My wife lugs around her
Windows laptop all over the house,
sometimes settling on the couch to
have tea, read the news, surf the
web for cosmetics, and upload
pictures. Seemingly she is happy
with Windows apart from the
occasional, “This thing seems to
get slower by the day.” Though she
has a laptop, our central desktop is
what she uses for Xbox streaming
when she is in the mood to watch
anime on the big screen (which is
often). She certainly has never

seen any version of Linux nor
would she understand how to deal
with virtual machines.

About the time I realize this,
she is walking down the stairs,
freshly awake from our previous
night’s anime marathon, laptop in
hand. The conversation goes
something like this:
“Goodmorning.”

“Goodmorning.”

“Whatcha doing?”

“Fixing the computer.”

“Whathappened?”

“I suspectmemorycrash maybe.”

“Idon’tknowwhat thatmeans but

okay. Howdidyou fix it?”

“InstallUbuntu.”

“Uhboontu, that’s a funnyword.

What is that?”

“A miracle on a disk.”

“Can I see?”

“Yep.”

Silence. I’m nervous. She says, “I
don’tget it.”

I say, “It fixedthe computer,
remember.”

“It’s different than mine.”

“Correction, betterthan yours. May I

showyouwhy?”

“I’ll neverunderstandwhyyou just
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can’t leave things alone.”

“But it fixedthe computer,”and
now I’m ready for a beat-down.
She’s moving the mouse around
and asks, “Can I surfthe Internet?”
“Yes. It hasFirefox.” (That’s her
favorite browser).
“Can Iuploadpictures?”

“Yes.” I hit the super-key, type
Shotwell, show her, and lock it to
the launcher.
“Can I listen to mymusic?”

“Yes” I hit the super-key, type
Rhythmbox, show her, and lock it
to the launcher.
“Then I trustyou.”

Relief.
“Wait, onemore question.”

Nervousness.
“Can I stream anime?”

I say, “Yeah, about that,” and
begin scratching my head in
thought about how to best explain
a virtual machine – when I have an
epiphany. Her laptop is STILL
Windows! I continue, “Give me a
few minutes and I’ll show you
how.” Install Samba, create share.
“Let me see your laptop honey.”
Permanently mount network drive,
configure Windows Media Center
to point to network share. “See,
now you can just download and
stream from your laptop!”

“That’s cool!Howdidyou do

that?”

To which I deviously reply, “I
didn’t, Ubuntu did. Toldyou it’s

better.”

About a week goes by and
everything is working great; I’m
walking down the stairs post-anime
marathon when I notice my wife on
the couch staring inquisitively into
the screen of her laptop. To my
delicious surprise I notice her
Windows taskbar had been moved
from the bottom of the screen to
the left side of the screen. Elation
warmed over me. She was
attempting to mimic Unity on a
Windows machine. She looks at
me, “Goodmorning.”

“Goodmorning.”

“I have a question.”

“I have an answer.”

She closes her laptop and gives
it to me, “Can youmake this
Ubuntu?”

Eureka!!! I say, “Uh, what, Idon’t
think I...whatdidyou just say?”

“Ubuntu, I’ve been reading about

itandusing yours, andyou’re right,

it is better.”

Double Eureka!!! I say, “Well
absolutely, my love.”And I go to

work liberating her laptop from
the clutches of the empire.

Moral of the story: given some
time, even the most novice user
will come to find Linux is a much
more pleasurable experience. It
takes the vigilance and willingness
on the part of us Linux aficionados
to take the time to show its
capability instead of arguing with
people who just want to “keep it
simple”, read news, surf the web,
look at pictures, and stream a
marathon’s worth of cute anime.

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.

The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org

http://podcast.ubuntu-uk.org/
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MMYY OOPPIINNIIOONN
Written by Ronnie Tucker

We used Facebook and
Google+ to let
readers know about
the emerging story

of how Richard Stallman doesn't
approve of Steam for Linux. An
except from the BBC News article
is below:

"Non-free game programs (like

othernon-free programs) are

unethical because theydeny

freedom to theirusers,"hewrote on

his blog.

"Ifyouwantfreedom, one requisite

forit is nothaving non-free

programson yourcomputer.

"However, ifyou're going to use

these games, you're betteroffusing

them on GNU/Linuxratherthan on

MicrosoftWindows."

Mr. Stallman saidthatbasedon this,

Valve'smovewas likely to domore

goodthan harm, buthe notedthere

wasanotherfactor.

"AnyGNU/Linuxdistro [distribution]

thatcomeswith software to offer

these gameswill teach users that

the point is notfreedom.

"Non-free software in GNU/Linux

distros alreadyworks against the

goal offreedom. Adding these

games to a distro wouldaugment

thateffect."

http://www.bbc.co.uk/news/techn
ology-19065082

YOUR COMMENTS

Luis Carvalho:
DRM is a cancer. Content with DRM
isn't sold, only rented, it's never
yours. Sooner or later, you'll lose
access to it. Bringing it to Linux is
an infection.

David White:
He had a point when it came to
operating systems and file utilities.
But not for this.

Davo Batty:
Bring it on, I use Steam to play
civ5, and playing games stops me
from migrating 100% to Linux.

Joan Trabal:
I'm pro F/OSS and against DRM,

but everyone should be free to use
whatever software suits their
needs. People just need more
education about these matters.

Rey Angeles:
The creator of the Linux kernel
pretty much gave it the green
light, yes, sure DRM is bad, how do
you expect them to make money if
they just give away their source
code. Guys, it’s not a Utopia and it
will never be. So, let’s try to work
with these companies to some
degree. I agree FOSS is best but
sometimes this model does not
work for everything.

Jeremy Davis:
It's a personal choice, but I have to
go along with anything that brings
more users to Linux, and games
will. Besides, I can stop dual
booting then.

Md. Rezaur Rahman:
I second Ray Angeles. In the real
world, we have to consider many
things. Gaming in Linux is still
pathetic. And GNU philosophy
doesn't work very well in the game
industry.

Robin James Banfield:
Stallman is a dinosaur. Using Linux
is a choice that everybody can
make. Choosing to purchase games
to play is also another. What
difference does it make if the
game you play is on an open-
source platform or if it’s on one of
the other 2. A lot more people will
switch to Linux if they could play
their favourite games on it. Kudos
to Valve for trying to make this
happen. Who [cares] about the
choice to modify the games. Time
for Stallman to crawl back in his
fossil.

Hassan Naderi:
Definitely against letting non-free
programs into GNU Linux.
Companies might have difficulties
making viable business models to
release software on Linux with
exclusively free code, but If you
start allowing non-free programs,
in a few years we end up having a
majority of programs with non-
free code.

Robin James Banfield:
Have to disagree with Hassan
(above), we already have open-

http://www.bbc.co.uk/news/technology-19065082
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IT HAS RETURNED!

The Full Circle
Podcast Returns!

It may be a new team of
podcasters, but the format
will be the same.

We'll be talking about Full
Circle Magazine, news,
reviews and interviews.

Your new team is:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark

All are members of the
Blackpool (UK) LUG
http://blackpool.lug.org.uk

Debut episode is
available from the
FCM homepage.

MY OPINION
source code being used on closed
sourced operating systems and
vice versa. I couldn't care less
about having the choice to modify
game code, I just want to play it.
What does modifying code for a
game really matter to the end
user? It seems that the point of
choosing an open-source OS has
been lost in the noble, but
impossible "crusade" to make all
code free. As much as I dislike
Redmond's OS, I still use it to play
games because I have to use it to
play games I like, and truth be told,
it has gotten a lot better since the
days of XP and before. With that
said, I wouldn't buy it if games
were created for use on Linux. It
seems the crusade itself is what is
actually holding the crusade back
from actual progress. You want a
successful OS? Have games that
are well supported from software
companies without the hassle. It's
worked for Redmond and
Cupertino. Why not Linux? While I
applaud people who create,
support, and maintain open-source
games, they are not that good. It
just isn't the same demographic
that big game companies are
aiming at. I have to agree with
Andy for the most part, but the
one thing I disagree on is that we
owe Stallman anything. It's his

crusade keeping Linux third in the
market-share by fighting to keep
gaming companies on the outside.
Linux is more than just free code
and open-source. It still is an
operating system that more
people would use if major
companies were allowed to
support their closed source
(games) on it.

Magne Djupvik:
Personally, I don't think allowing
users the freedom to use Steam is
wrong, and I might end up using it
myself. But at the same time, I
think people should support the
Free Software games that exist.
Shameless plug: SuperTuxKart
(which I'm somewhat involved in)
has its forums at the
FreeGameDev.net forums, and we
definitely would like any help we
could get in making the game
better, be it donations, artwork,
code, or other things. Or just some
constructive feedback. The
FreeGameDev forums are really
nice, and an important place to
help out various developers who
aren't raking in lots of cash making
their games. And, unlike
commercial games, those games
will always be able to work and be
improved on due to them being
open source and DRM free.

Andy Gait:
As Linux users we owe Stallman a
debt, but time and computing has
moved on. Stallman is so blinkered
in his beliefs that anyone who
doesn't follow his way to the letter,
is wrong. No debate. No reasoning.
Just wrong. He's no longer an open
source guru, he's a dictator.

Brook Smith:
Open source, closed source? Who
cares if they are wanted by the
user and they work. We, the users,
matter more than any one’s
crusade for open source software.
Do I prefer open source solutions
where possible? Certainly! But it's
not always possible. Realistically,
programmers need to be
compensated at some point, many
make their living writing computer
code. This means that the software
their employer sells goes toward
paying their wage, this puts food
on their table, a roof over their
head, and helps support their
family.

http://blackpool.lug.org.uk
http://fullcirclemagazine.org
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http://www.ubuntu-user.com/subscribe-now/
http://www.ubuntu-user.com/subscribe-now/
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RREEVVIIEEWW
Written by Vince Du Beau

I have Ubuntu 12.04 installed
on a separate drive on my
MacBook. One of the main
uses of the MacBook has been

as a media center using XBMC,
which works very nicely with the
Apple remote control. This
unfortunately is not the case with
Ubuntu, or most distributions.

If you've tried to get lirc
working with a remote control, you
know it's a daunting task and
probably didn't work. Flirc comes
to the rescue.

Flirc (http://www.flirc.tv/) is a
hardware/software combination
that makes setting up your remote
control as simple as getting cash

from an ATM.

The hardware is a small USB
dongle that you just plug into any
USB port.

Flirc doesn't use lirc but instead
acts as a secondary keyboard so
that you are actually sending
keystrokes to XBMC.

Programming the dongle
requires getting the software from
the website. It is available for
Linux, OS X, and Windows. For
Linux there are only instructions
for installing on Ubuntu:

Installation
Instructions For Ubuntu
i386:
1. Add:
deb

http://apt.flirc.tv/arch/i386

binary/

to /etc/apt/sources.list
2. apt-get update
3. apt-get install flirc

Installation
Instructions For Ubuntu

x64:
1. Add:
deb

http://apt.flirc.tv/arch/x64

binary/

to /etc/apt/sources.list
2. apt-get update
3. apt-get install flirc

Once you have the appropriate
version installed, plug the dongle
in, click on the Dash Home icon,
and type “Flirc” into the search box
and just click on the Flirc icon.

The screenshot below shows
the initial screen. You can program
your basic remote functions here. I

thought this to be ideal for using
the Apple remote since it was the
exact number of buttons on the
remote. There was a downside to
the way Flirc acts as a keyboard.
On the Mac (and probably a proper
lirc setup on Linux), XBMC knows
where it is in terms of screens. If
you are browsing a list of movies,
the up/down buttons navigate the
list; if you are watching a movie,
they control the volume. Since Flirc
just sends keystrokes, the up and
down buttons would jump back
and forth through the movie. I
bought a cheap universal remote
which would give me more keys to
utilize.

FFlliirrcc

http://www.flirc.tv/
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REVIEW

Flirc has a built-in configuration
editor for XBMC. To access it, on
the main menu click on
Controllers->XBMC, and you will
be presented with the following
screen.

As you can see, when you select
a function it prompts you to push
the corresponding button on the
remote. To ensure that all remote
functions were active, I selected
the DVD option on the remote. At
first this didn't work 100%. I had to
play with the programming of the
remote until I had the proper DVD
player selected. Once I got that
right, I had remote control nirvana.

If you find you need even finer
programming of your remote, Flirc
also provides a full keyboard

configuration accessed by going to
Controllers->Full Keyboard. This
will bring up the following screen
where you tweak as much as you
like. Go to
http://wiki.xbmc.org/index.php?titl
e=Keyboard to find a list of the
keyboard controls available.

Pros: A quick and easy way to set
up XBMC on Ubuntu to use as a
Media Center. At $24.95 plus
shipping, it's a bargain!

Cons: The only real downside I
came across is getting the right
DVD player set on the remote. I
don't consider this a big issue as
you can have the same problems
with any remote and whatever
hardware you may be using in your
home entertainment center.

1166xx1166 SSUUDDOOKKUU

Solutions are on the second last page.

Numbers 0 to 9 and letters A to F are to be filled into the
16x16 grid so that every row, every column, and every
4x4 box contains 0 to 9 and A - F.

Puzzles are copyright, and kindly provided by,
The Puzzle Club - www.thepuzzleclub.com

http://gpodder.org/
http://wiki.xbmc.org/index.php?title=Keyboard
http://www.thepuzzleclub.com
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LLEETTTTEERRSS
Every month we like to publish some of the emails we receive. If you would like to
submit a letter for publication, compliment or complaint, please email it to:
letters@fullcirclemagazine.org. PLEASE NOTE: some letters may be edited for space.

The Fastest Little
Laptop

I thought of this after reading
the column entitled “Making
*buntu 12.04 Boot Faster” in
issue #63. The fastest little

laptop computer I ever saw was a
Dell Inspiron 11z. This laptop has
been discontinued. If you can find
one and you are looking for a
super-fast cheap laptop, this is one
to consider. Here's what you have
to do to make it boot and run fast.

This little baby came with 2 GB
of RAM, so what you want to do is
get two 4 GB sticks of RAM and
replace the 2 GB with 8 GB. Very
easy to do. Remove power cord
and battery, and just remove the
plate on the bottom of the laptop
(one screw) and pop out the 2 gig
and replace it with one of the 4 gig
sticks, and install the other right
on top of it. There are two memory
slots. Replace the plate and the
screw. You’re Done.

Next, watch for a good deal on
a Solid State Drive (SSD) and
replace the Hard Drive. This is a

little tricky. You need to again
unplug the power cord and remove
the battery, and remove three
screws from the bottom of the
laptop, turn the laptop right-side
up, and pop the keyboard out
using a credit card – working the
keyboard out without breaking it.
Be careful with a small wire
connection. The hard drive is under
the keyboard. Remove one screw
that holds the hard drive in, and
replace it with the SSD. Pop the
keyboard back in and put the three
screws back in the bottom.
Reinstall the battery. Done.

Now, install Ubuntu 12.04 from
a USB drive. When you are done
you will have a little 11.6” i3 Intel
processor with 8 GB memory and a
SSD laptop that boots up in less
than 15 seconds, and where the
apps just load almost instantly. The
battery life is good on this little
unit. The mini-laptops and
Netbooks are all just a little too
small, but this one seems to be just
the right size.

Now, the good news is this: If
you look, you can find this little

jewel for under $300. I found one
for $289. I found an SSD, 180 GB,
for $149, and the 8 GB of RAM for
$39, so the total price for all was
$477. I thought this was a very
good deal and if you are looking
for a very fast full-blown Ubuntu
12.04 carry-around computer that
will keep you Ubuntuing no matter
where you are, here is one. You
can't go wrong.

In closing, let me also add, if
you have an older laptop and you
want to really speed it up, you can
just add more memory and a SSD,
and you can make your older
laptop run like new. I have a Dell
Inspiron 1521, and I have the
memory maxed out at 4gig and
added a 180gig SSD, and it runs as
fast the the 11z – but it’s a little
bigger to carry around, and with
shorter battery life. I believe the
11z is about 3 lbs, whereas the
1521 with a 9-cell battery is about
7 lbs. I am only guessing on the
weight.

Irv Risch

UEFI Horror

I was shocked to learn about
UEFI and Microsoft's (not
surprising) anti-competitive
behavior on the latest Full

Circle Podcast.

Ever since I have been a nerd
(the open source type), I revelled
and delighted in the fact that I
could buy a PC or laptop, format
the hard drive to get rid of the
resident Windows OS, and then, in
a matter of minutes, install an
open source operating system
such as Ubuntu or other Linux

Join us on:

facebook.com/fullcircle
magazine

twitter.com/#!/fullcirclemag

linkedin.com/company/full-
circle-magazine

ubuntuforums.org/forum
display.php?f=270

goo.gl/FRTMl

mailto:letters@fullcirclemagazine.org
http://facebook.com/fullcirclemagazine
https://twitter.com/#!/fullcirclemag
http://linkedin.com/company/full-circle-magazine
http://ubuntuforums.org/forumdisplay.php?f=270
http://goo.gl/FRTMl
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LETTERS
distro.

But a new boot system called
UEFI Secure Boot is being
prepared to exclusively lock the
forthcoming Windows 8 to
hardware, at best obliging users to
pay a fee to obtain a new key in
order to enable them to install an
alternative OS.

Reading around the subject, I
seem to find a kind of consensus
that even if this new development
is a bother, it nevertheless solves a
legitimate issue, and that some
sort of collaboration with
Microsoft and hardware vendors is
the only solution to the problem.

I am completely baffled that
what to me is blatant anti-
competitive behaviour is being
apparently accepted by a large
portion of the tech community.
How can we have this on the one
hand, and anti-trust laws obliging
Microsoft to offer alternatives to
its IE web browser on its Windows
7 OS? In the latter case, even if MS
were not to offer these options,
the user would still be free to
install the other browsers, or,
failing that, install another OS
altogether which comes with
alternative browsers already

installed. But in the case of UEFI
Secure Boot, the user is effectively
barred from freely installing
alternative software of his choice.

Personally, I think this abusive
approach by Microsoft will backfire
like many recent strategies carried
out by the software giant. It is also
a sign that MS is worried about
alternative free OSs (such as
Ubuntu 12.04) which are almost
certainly far superior to its still-to-
be-launched Windows 8.

There is a considerable
community of open source
software users out there, and I
think that they have a weight that
will make itself felt in this new
environment. A smart hardware
manufacturer that publishes a
range of non-UEFI Secure Boot
machines could well see its sales
skyrocket as the open source
community rushes to its doors.

But what about antitrust
bodies? What are they saying
about the impact of UEFI Secure
Boot on free competition? What do
fellow geeks feel? What are they
going to do about it?

I have a feeling that, in the end,
the threat will fizzle out, it's just

too far fetched a scenario to be of
any substance.

Anybody out there share my
views?

Yan Volking

Ronnie says: I’’ve sentan email to
the spokesperson forthe antitrust

commission forEurope to seewhat

theyknow(ifanything) andwhat

they intendto do (ifanything) about

UEFI. I’ll reportback ifI hear

anything.

Gord adds: UEFI is pure progress,
the only issue is Secure Boot.

Microsoftwants to require Secure

BootonWindows8Arm processors,

which is laughable, since a vast

majorityofArm processors run

Androidorsome otherform ofLinux.

On x86(Intel orAMD) processors,

you shouldbe able to disable Secure

Boot.

A Quick Tip

Some people complain about
Unity. It is different, there is no
doubt about it. I have found it

useful. Quick access from the
Super key and the Alt-F2
combination for those command
line interface software that just
needs one quick line. As an
example, I use pdftk
(http://www.pdflabs.com/tools/pd
ftk-the-pdf-toolkit/) to extract
pages from pdf documents. I used
this command to perform a quick
two-page extraction without
opening a terminal.

pdftk MCI.pdf cat 28­29

output MCI2.pdf

For this to work, I placed the
MCI.pdf at my home folder and the
MCI2.pdf was created in the home
folder too. You will have to know
the commands to use, and for that
you will most likely open a terminal
to get to the pdftk man page. Once
you get to know your most used
commands, it will be a precise
shortcut.

Jesse Avilés

http://www.pdflabs.com/tools/pdftk-the-pdf-toolkit/
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QQ&&AA
Compiled by Gord Campbell

If you have Ubuntu-related questions, email them to:
questions@fullcirclemagazine.org, and Gord will answer them in a future
issue. Please include as much information as you can about your problem.

Q My computer boots to a
black screen, what can I
do?

A I've dealt with this
before, but not this well:

http://askubuntu.com/questions/1
62075/my-computer-boots-to-a-
black-screen-what-options-do-i-
have-to-fix-it

Q I have audio issues. Using
Google produces far too
many "fixes," and most of
them are obsolete.

Ahttp://voices.canonical.c
om/david.henningsson/2
012/07/13/top-five-

wrong-ways-to-fix-your-audio

The author provides
alternatives to the obsolete
approaches. My favorite:
"model=auto".

Q I installed Ubuntu on a
small hard drive, and now
it's out of space. I
managed to add a

somewhat larger hard drive, what
can I do now?

A (Thanks to OM55 in the
Ubuntu Forums) You can
clone the existing
installation to the larger

hard drive, using Image for Linux.
http://www.terabyteunlimited.com
/image-for-linux.htm

When done, you can mount the
old (smaller) drive as additional
available disk space for your new
drive.

Q When you have two
monitors, and you
enable: System Settings >
Appearance > Behavior >

Auto-hide the Launcher, your
mouse will stick within the Unity
hot spot region until you wiggle
your mouse free.

A (Thanks to ResQue in
the Ubuntu forums) Go
into System Settings >
Displays and set the

following:

Launcher placement = Laptop (this
will stop the unity bar appearing
on both screens)

Sticky edges = Off (this will stop
the mouse cursor getting stuck
between screens.)

Q How do you convert
AVCHD video file (MTS)
to MP4 or WMV?

A Install Winff and run it.
You will probably want
to do some reading
about quality settings; if

you get carried away, you can
produce enormous files.

Q Where can I find an Intel
64-bit distro?

A Distros labelled as
"AMD 64" are 64-bit
distros for both AMD
and Intel processors.

Q How do you crop a video
in openshot?

Ahttp://www.openshotus
ers.com/help/1.3/en/ar0
1s15.html

Q I currently have a dual
boot set-up with
Windows Vista Business
and Ubuntu 10.04. The

Windows Vista OS is now crashing
pretty well every time I use it. I
have decided to re-install the
Windows Vista (which I need for
my work) using 2 Recovery DVD
disks that I created back in 2009
when I got the (Toshiba Satellite

mailto:questions@fullcirclemagazine.org
http://askubuntu.com/questions/162075/my-computer-boots-to-a-black-screen-what-options-do-i-have-to-fix-it
http://voices.canonical.com/david.henningsson/2012/07/13/top-five-wrong-ways-to-fix-your-audio
http://www.terabyteunlimited.com/image-for-linux.htm
http://www.openshotusers.com/help/1.3/en/ar01s15.html
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Q & A
Pro) laptop. When I do that, I've
been led to believe that the laptop
will stop recognising the Linux OS?

A (Thanks to darkod in
the Ubuntu Forums)
Installing Windows will
delete the grub2

bootloader from the MBR and the
Windows bootloader can't boot
Linux. If the recovery process only
installs Vista on the current
partition, not touching the Ubuntu
partitions, you can simply use the
10.04 Ubuntu cd in live mode and
return grub2 to the MBR with
these instructions:
http://ubuntuforums.org/showthr
ead.php?t=1014708

Q I have an annoying issue
with 12.04, it keeps
changing my BIOS time. I
have the clock set in

Ubuntu to the correct time but
when I shut it down and boot back
up, the BIOS clock is set a few
hours off again every time. I also
use Windows 7 (separate drive)
and that's how I realized the BIOS
time was wrong. In Windows it
goes by the BIOS time.

A (Thanks to mcduck in
the Ubuntu Forums)
Your problem is caused
by both Windows and

Linux using the system clock from
BIOS, but while Windows assumes
the system clock is running in your
local time, Linux (like most Unix-
like operating systems) assumes
the system clock to run in UTC time
instead. To change this behaviour:
https://help.ubuntu.com/communi
ty/UbuntuTime#Multiple_Boot_Sys
tems_Time_Conflicts

Q I set up an old desktop
computer with Ubuntu
Server 11.10. I have two 1
TB drives set up with LVM

(Logical Volume Manager, which
lets you treat the two drives as a
single drive), and an 8GB USB drive
set up with the OS. Found out
today that the USB drive failed.
How can I restore the LVM?

A (Thanks again to darkod
in the Ubuntu Forums)
Install Ubuntu Server on
a new flash drive. After

installing the OS, or during
installation, you can activate and
mount the LVM easily. If you do it
during OS installation, make sure

you don't delete it. Or, simply
ignore it (leave it as not used)
during OS install, and create an
entry in /etc/fstab after that.

Tips and Techniques
Cleaning Windows

One of the things Linux users
gloat about is freedom from
malware. At the same time, many
Linux users dual-boot in order to
run Windows games. Therein lies
the problem: what to do when
malware invades your Windows
partition?

I didn't have any malware, but I
set out to answer the question.

My laptop triple-boots Windows
7, Linux Mint 13 and Ubuntu 12.04.
All of them are 64-bit versions.

When I searched on the web, it
appeared that the preferred
method of cleaning a Windows
partition was the Linux version of
Avast!. When I tried to run 32-bit
Avast! under Ubuntu 12.04, 64-bit
version, it disgraced itself, saying,
"An error occured in Avast! engine:
Invalid argument".

OK, let's try 32-bit Ubuntu. I
downloaded the ISO, then installed
Multisystem, which has proven to
be a reliable way to make a
"persistent" flash drive.
("Persistent" means that when you
install something and reboot, it's
still installed.) Creating the flash
drive took a few minutes, and
creating 4 GB of persistent space
took many minutes. Fortunately,
my flash drive has a blinking
activity light, so I could see that
something was happening.

Boot from the flash drive,
beauty! Then my personal
preferences came into play, which
really slowed things down. First, I
ran Software Center and installed
Synaptic Package Manager. Ran
System Settings, selected
Brightness and Lock, and selected
"Never" for "Turn screen off when
inactive for:". Ran Synaptic, and
added Multiverse to the
Repositories. Reloaded. Installed
conky, lm-sensors and hddtemp,
because I always want to see how
hot things are. Then I made my big
mistake, and installed all the
updates. Running from a flash
drive, that can take hours. Then:

sudo apt­get clean

http://ubuntuforums.org/showthread.php?t=1014708
https://help.ubuntu.com/community/UbuntuTime#Multiple_Boot_Systems_Time_Conflicts
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CCOODDEEWWOORRDD

Solutions are on the second last page.

Every number in the grid is 'code' for a letter of the alphabet.
Thus the number '2' may correspond to the letter 'L', for instance.
All - except the difficult codeword puzzles - come with a few
letters to start you off

Puzzles are copyright, and kindly provided by,
The Puzzle Club - www.thepuzzleclub.com

After a long career in the computer
industry, including a stint as editor of
Computing Canada and Computer
Dealer News, Gord is now more-or-
less retired.

Q & A

to free up the space used by the
downloaded updates.

Now I can install the previously
downloaded Avast! .deb file.
There's an error message which I
ignore. Run it, and copy in the
registration key which I obtained
previously. Update the database,
and here comes the same error
message. Argh!

This can't be right. I Google:

avast invalid argument solved

and get to this page, which has the
solution:
http://crunchedd.com/2012/03/26/
solved-an-error-occured-in-avast-
engine-invalid-argument/

I applied that solution to the
Ubuntu on my hard drive. Now
Avast! ran, and I got to the tricky
(!!!) part. I ran the file manager, and
selected the Windows partition

("164 GB Filesystem" on my
computer) which mounted it. In
Avast! I selected to scan Selected
Folders. From Root (right at the
bottom of the selection screen) I
selected media, and there was just
one item within it: the Windows
partition. I selected it, and away we
went.

As expected, no malware was
identified. But it shouldn't be this
hard.

http://www.thepuzzleclub.com
http://crunchedd.com/2012/03/26/solved-an-error-occured-in-avast-engine-invalid-argument/
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UUBBUUNNTTUU GGAAMMEESS
Written by Jennifer Roger

The first half of 2012 has
seen an explosion of new
indie games – thanks to
crowd funding websites

and a very generous gaming
community. Luckily, there has also
been an increase of games that will
be released natively for Linux.
Here are my picks of the top five
upcoming Linux games to watch
for.

Bacillus
(Milky Joe Games)
http://www.kickstarter.com/projec
ts/534715294/bacillus?ref=live
Release Date: August 2012

Bacillus is a science lover’s dream.
Your goal is to survive by
controlling a population of
bacteria as you multiply and
explore your environment. Creator
John Halter has gone to great
lengths to accurately capture the
world of microbial life, and make it
available for gamers to experience.
The game incorporates biological

concepts such as genetics,
enzymes, and evolution. Bacillus is
extremely detailed and complex,
but that’s part of what makes it so
intriguing. It is currently in beta for
Windows; however the Linux and
Mac versions are still in the alpha
stage.

Nekro
(Darkforge)
http://www.kickstarter.com/projec
ts/343838885/nekro
Release Date: June 2013
If you have always wanted to take a

stab at playing the bad guy, Nekro
is the game for you. In this dark
top-down action game, you control
a necromancer who uses spells to
summon evil creatures and
minions. You are part of the Nekro
– one of the three factions vying
for control in the world. The
objective is to defeat the humans
and the neutrals, conquer as many

regions as possible, and reach the
final battle with the King.
Darkforge has just added a
multiplayer mode, so players will
also be able to take on the
opposing factions with friends.
Nekro’s unique art style and
graphics, as well as its innovative
gameplay, offer players a new
action game experience.

Super Retro Squad
(Exploding Rabbit)
http://www.kickstarter.com/projec
ts/explodingrabbit/super-retro-
squad
Release Date: March 2013
A few years ago, Jay Pavlina (lead
programer at Exploding Rabbit)
released Super Mario Crossover, a

mashup of various Nintendo
games. Thanks to a successfully
funded Kickstarter and the
addition of a full crew, Exploding
Rabbit is working on its own

original 2D platformer, Super
Retro Squad. The game will have
40+ levels within eight different
worlds that are based on each of
the characters. The characters are
a tongue-in-cheek ode to well
known Nintendo characters. For
example, Manni and Lanzo are
German miners who find
themselves in the Asparagus
Kingdom on a quest to save
Princess Apricot. Super Retro
Squad is more than just a game
with 8-bit graphics and a chiptune
soundtrack - it’s a clever take on
many of the classics we all loved to
play as kids.

Auro
(Dinofarm Games)
http://www.kickstarter.com/projec
ts/dinofarmgames/auro
Release Date: December 2012
Auro is a gorgeous game that

TToopp 55

http://www.kickstarter.com/projects/534715294/bacillus?ref=live
http://www.kickstarter.com/projects/343838885/nekro
http://www.kickstarter.com/projects/explodingrabbit/super-retro-squad
http://www.kickstarter.com/projects/dinofarmgames/auro
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Jennifer is a fine arts student from
the Chicagoland area. You can follow
@missjendie on Twitter or visit her
blog at missjendie.com.

UBUNTU GAMES
combines turn-based strategy and
dungeon crawling goodness. You
play as the spoiled Prince Auro
who sets out on a quest to protect
the sewers, but accidentally
awakens an ancient evil power.
Auro has many spells and abilities
at his disposal, but players must
really consider their strategy as
there are significant pros and cons
with every action. The monsters
also have special abilities that can
affect how Auro chooses to defeat
them. The dungeons are randomly
generated, so you get a slightly
different experience each time you
play. Dinofarm Games has had
previous success with iOS, and,
thanks to Kickstarter, are now
going multi-platform, including a
Linux release this December.

Legends of Eisenwald
(Aterdux Entertainment)
http://www.kickstarter.com/projec
ts/1684781151/legends-of-
eisenwald
Release Date: Early 2013
Legends of Eisenwald is a

beautifully polished 3D strategy
RPG. The world of Eisenwald is
unique in that it steers clear of the
common RPG themes such as elves
and orcs. In lieu of typical fantasy
influences, Aterdux borrowed real
life concepts from the medieval
era, which is refreshing to see. The
turn-based combat focuses on
efficiency. Players must choose
wisely as every move and decision
can greatly affect the outcome of a
battle. The variety of choices for
unit, weapon, and spell upgrades
looks quite promising. Visually,
there is incredible detail in the
environments and characters.
Although they met their funding
goal, Aterdux was unable to reach
the 100K Kickstarter stretch goal
for Linux, but you can still donate
via PayPal to help them reach an
early 2013 release for Linux.

Ubuntu One & KDE

Although Ubuntu One can be installed in KDE to give you the
Ubuntu One folder. What you don't get is the ability to right
click on a file, in your Ubuntu One folder, publish it, and get
the share URL. Normally, you'd need to do the sharing part

via the Ubuntu One web site. Thankfully, ShaneQful
(www.softwareontheside.info) has come to the rescue with a fantastic
little Ruby script that will give us the missing right click functionality.

First, install Ubuntu One:

sudo apt­get install ubuntuone­control­panel­qt

Now, run the Ubuntu One app and go through the setup wizard.
Next, we need to install ShaneQful's script and its dependencies:

sudo apt­get install ruby && sudo apt­get install git

cd ~/.kde/share/kde4/services/ServiceMenus/

rm ­rf Ubuntu\ One/

git clone https://github.com/ShaneQful/u1­dolphin.git

mv u1­dolphin/ UbuntuOne

Drag a file to your
Ubuntu One folder and
it'll be uploaded to the
cloud. Right click on it and
you'll see the option for
Ubuntu One > Publish and
Copy Web Link. There's
also an option to stop the
sharing of a shared file.

http://missjendie.com
http://www.kickstarter.com/projects/1684781151/legends-of-eisenwald
http://www.softwareontheside.info
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MMYY DDEESSKKTTOOPP

I am from Sri Lanka, and this is my desktop. I am a Ubuntu user
since 2010. I started using Ubuntu from version 10.04. My
desktop is a very simple one. I've used compiz to get the
transparent look in the top panel, as a launcher, and to reduce
the icon size of the launcher.

OS: Ubuntu 11.10, Icons: Faezna Darker, GTK+ Theme: Aldabra,
Window Theme: Shiny, CPU: Intel Pentium Dual Core 2.0GHz,
RAM: 3GB, HDD: 160GB+500GB

Sumith Kumara

Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

I started using Linux in 2007 and am currently experimenting
with Mint 12 (Lisa). “Hot-babe” on the right lower corner starts
stripping as my rig gets more and more active. Sticky notes on
top right help me in keeping track of important things. The
theme and wallpaper are preloaded.

System Specs: Core 2 Duo, 3 GHz, 2GB RAM, 250GB HDD, 17”
TFT Monitor @1280 X 1024 Resolution, Keyboard
configuration DVORAK

HM Chandrasekhar

mailto:misc@fullcirclemagazine.org
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MY DESKTOP

I'm from Russia and recently switched to Ubuntu and am very
pleased.

This is my desktop. I work in Ubuntu 12.04 LTS. My computer
is a Toshiba Satellite L 500 1Q6.

Specs:
Processor: Pentium (R) Dual-Core CPU T4300@2.10GHz × 2
RAM: 2.8 GB memory
Graphics: Mobile Intel ® GM45 Express Chipset
64-bit OS

Themes Gtk and windows: Lucidity
Themes icon: faenza-darker
Themes cursor: handhelds

Dmitry

So here is my desktop, using combination cairo-dock and
docky. In the top is cairo-dock, and bottom is docky. My
wallpaper is "persija" a football group from my town,
Jakarta, Indonesia. I installed ubuntu 11.10 on my laptop
Acer Aspire 4740G and the spec is: core i5 430M, nVidia
GeForce 310M, 2GB RAM. I love simplicity – that's why I use
only this two-dock approach. "Viva Linux World".

Ashwin Dexter Winongo
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PUZZLE SOLUTIONS
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Codeword and 16x16 Suduko puzzles are
copyright, and kindly provided by, The Puzzle
Club - www.thepuzzleclub.com
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HHOOWW TTOO CCOONNTTRRIIBBUUTTEE

We are always looking for new articles to include in Full Circle. For article
guidelines, ideas, and for issue translation, please see our wiki:
http://wiki.ubuntu.com/UbuntuMagazine
Please email your articles to: articles@fullcirclemagazine.org

Full Circle Team

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Comms Mgr - Robert Clipsham
mrmonday@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org

Editing & Proofreading

Mike Kennedy
Lucas Westermann
Gord Campbell
Robert Orsino
Josh Hertel
Bert Jerred

Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

If you would like to submit news, email it to: news@fullcirclemagazine.org

Send your comments or Linux experiences to: letters@fullcirclemagazine.org

Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org

Questions for Q&A should go to: questions@fullcirclemagazine.org

Desktop screens should be emailed to: misc@fullcirclemagazine.org

... or you can visit our forum via: www.fullcirclemagazine.org

Deadline for FCM#65:
Sunday 09th Sept. 2012.

Release date for FCM#65:
Friday 28th Sept. 2012.FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no exception. We need
your Opinions, Desktops and Stories. We also need Reviews (games, apps &
hardware), How-To articles (on any K/X/Ubuntu subject) and any questions, or
suggestions, you may have.
Send them to: articles@fullcirclemagazine.org
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